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1 Overview 
1.1 Benefits 

� Easy Backup of 
1. Microsoft Exchange Server 2000 / 2003 
2. Microsoft SQL Server 7.0 / 2000 
3. Lotus Domino/Notes 5.0 or above 
4. Oracle 8i or above 
5. MySQL 3.2.4 or above 
6. Windows System State 
7. Outlook and Outlook Express (i.e. *.pst, *.dbx and *.wab) 
8. Important personal settings, e.g. Desktop, Favorite, My Documents and History etc 
9. Other common files (e.g. *.doc, *.xls) 

� Support of backing up only changes within a file (using in-file delta technology) 
� Support of backing up of open files on Windows XP/2003 (Volume Shadow Copy) 
� (New in 5.1.0.6) Support of backing up of Windows NTFS access privileges, Linux access privilege and 

mode, Mac OS X metadata and resource forks 
� Easy to use, deploy and maintain 
 

1.2 Features 
� (New in 5.1) User configurable incremental / differential in-file delta backup mode (i.e. backing up only 

changes within a file since last incremental backup (or last full backup) according to each user’s 
preferences)  

� (New in 5.1) Allow in-file delta backup mode to be overridden by each user individually according to 
backup time (e.g. enforcing full (or incremental or differential) backup of all files on every Sunday or the 
1st day of every month)  

� (New in 5.1) Single mail level exchange backup (brick level exchange backup)  
� (OEM version only) All references to Ahsay can be removed or branded to your own company name, 

address, phone and email 
� (OEM version only) Allow unlimited backup trial accounts to be created on the backup server (with 

unlimited backup quota for a trial period of 30 days) 
� (OEM version only) Create branded installer for backup client software. No special setup is required to 

offer free trial subscriptions to potential users  
� Volume Shadow Copy backup (i.e. backing up files even when they are exclusively open, e.g. 

Outlook.pst) 
� Bandwidth Throttling at backup account level (new) In-File Delta backup (i.e. backing up only changes 

within files) 
� Off-line backup mode and logout backup reminder 
� Real time backup server replication allows backup server to be easily backup 
� Customizable backup schedule allows backup to be scheduled at any time  
� Compress and encrypt data automatically before sending them to the server (server stores only 

encrypted data) 
� Increment backup strategy ensures that only new or updated files (or changes with last backup file) are 

sent to backup server 
� Support both full backup (database backup) and incremental backup (transaction log backup) for 

Microsoft SQL Server 7.0/2000, Microsoft Exchange Server 2000/2003, Lotus Domino/Notes 5.0 and 
Oracle 8i or above 

� Can integrate with external “Open File Manager” to provide open file backup support to all open files 
� Access backup data anytime, anywhere by using a browser 
� Comprehensive backup report lists all files being backup. Backup report will be delivered to user 

automatically via email when each backup job completed.  
� Backup data are CRC validated before they are stored on server. 
� Fully user customizable data retention policy allows users to have access to deleted files using the 

least possible storage space on server 
� Select files to be backed up easily by using backup filter, e.g. selecting all *.doc and *.xls in your 

computer in a single operation 
� Run any custom OS commands before/after a backup job. 
� Run on Windows, Mac OS X, Linux, NetWare, Unix and all other platforms supporting a Java2 Runtime 

Environment. 
� LiveUpdate allows patches to be deployed to hundreds of clients easily 
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� System activity report, showing all backup system information, will be delivered to system administrator 
via email everyday. 

� Complete set of external APIs allow system integration with external systems (e.g. billing/payment 
system) to be done easily 

� Periodic backup files validation on backup server ensures backup files are 100% valid and fully 
restorable when needed. 

 

1.3 Security 
� 128-bit point-to-point SSL communication between server and client 
� Support HTTP/HTTPS Proxy and Socks v4/v5 firewall  
� Data are 128-bit encrypted when stored on backup server 
� Choice of different encryption algorithms, e.g. Twofish, Triple DES, Advanced Encryption Standard 

(AES) 
� Choice of different encryption modes, e.g. Electronic Cook Book (ECB) and Cipher Block Chaining 

(CBC) 
� An random initializing vector, salt and iteration count will be generated by the software automatically for 

each file when encrypting your data 
� Each backup user can restrict online access to his files to his pre-defined list of IP addresses 
 

1.4 System Requirements 

Server Software (AhsayOBS) 

� Operating System: 
1. Windows 2000 / XP / 2003 * 
2. Linux kernel 2.2 or above ** (e.g. RedHat Linux 6.x or above, though the use of Linux kernel 

2.6.9-34 or above is recommended) 
3. Mac OS X 10.2 or above 
4. All other operating systems that supports Java2 Runtime Environment 1.4.1 or above 

� Memory: 128MB (minimum), 512MB (recommended) 
� Disk Space: 250MB  
� Network Protocol: TCP/IP (http/https)  

 
* The use of Windows 2000 WorkStation and XP Professional is only recommended for backup system with less 
than 20 users. For 20 or more users, please use Windows 2000 or 2003 Server instead. 

 

Client Software (AhsayOBM) 

� Operating System: 
1. Windows 95 / 98 / ME / NT / 2000 / XP / 2003 
2. Linux kernel 2.2 or above ** (e.g. RedHat Linux 6.x or above, though the use of Linux kernel 

2.6.9-34 or above is recommended) 
3. Solaris 2.x or above 
4. Mac OS X 10.2 or above 
5. NetWare 5.1 or above 
6. All other operating systems that supports Java2 Runtime Environment 1.3.1 or above 

� Memory: 128MB (minimum), 256MB (recommended) 
� Disk Space: 100MB  
� Network Protocol: TCP/IP (http/https) 

 
** Standard C++ libraries for backwards compatibility compiler (compat-libstdc++-x.x-y.y.y.y.i386.rpm) must be 
installed if you are not using a Linux 2.2 kernel. These libraries are required to run all Java applications. 
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2 AhsayOBM Configuration 
Before you can start backing up data to Ahsay Offsite Backup Server, you need to install AhsayOBM (AhsayOBM) 
onto your computer.  

2.1 Installation 
Please follow the instructions below to install AhsayOBM onto your computer.  

i. Click the one of the language links under the [Download Client Software] section 
 

 
 
Or click the [Install Software] link available at the top of the [Online Backup Services Management 
Console] 
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ii. Select the operating system to which you want to install AhsayOBM 
 

 

iii. Follow the instructions on the installation guide to complete AhsayOBM installation 

Notes on Windows Installation 

A quick launcher is now installed in the system tray (next to your system clock). To open AhsayOBM, just right 

click the quick launcher icon  and choose [Open].  
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2.2 Upgrade 
This section describes the software upgrade instructions required to upgrade AhsayOBM to the latest release. 

Upgrade instructions of AhsayOBM on Windows 

Download the latest installer (obm-win.exe) from the web installation guide and install it over existing installation 
of AhsayOBM. It will upgrade the AhsayOBM to the latest version. 

 

Notes: 
You will only be prompted to reboot your computer if some files are locked and cannot be overwritten during 

upgrade. 
 

Upgrade instructions of AhsayOBM on Netware 

a. Download the latest release bundle (obm-netware.zip) from the web installation guide. 
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b. Backup existing installation by renaming SYS:\OBM to SYS:\OBM.bak 

c. Restarting backup scheduler by running SYS:\OBM\bin\Scheduler.ncf 

d. You can then open AhsayOBM by running SYS:\OBM\bin\BackupManager.ncf 

Upgrade instructions of AhsayOBM on Mac OS X 

a. Download the latest release bundle (obm-mac.zip) from the web installation guide.  
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b. Expand the zip archive and run the AhsayOBM installer inside the archive 

Upgrade instructions of AhsayOBM on Linux 

a. Download the latest release bundle (obm-linux.tar.gz) from the web installation guide 
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b. Stop running backup scheduler by running 
 
# touch $OBM_HOME/ipc/Scheduler/stop 

c. Backup existing installation by renaming $OBM_HOME (default directory is /usr/local/obm) to 
$OBM_HOME.bak 
 
# mv /usr/local/obm /usr/local/obm.bak 

d. Expand the new client software to $OBM_HOME 
 
# cd $OBM_HOME 
# tar xvfz obm-linux.tar.gz  

e. Start backup scheduler by running $OBM_HOME\bin\Scheduler.sh 

f. You can then open AhsayOBM by running $OBM_HOME\bin\BackupManager.sh 

Upgrade instructions of AhsayOBM on Sun Solaris 

a. Download the latest release bundle (obm-solaris.tar.gz) from the web installation guide 
 

 

b. Stop running backup scheduler by running 
 
# touch $OBM_HOME/ipc/Scheduler/stop 

c. Backup existing installation by renaming $OBM_HOME (default directory is /usr/local/obm) to 
$OBM_HOME.bak 
 
# mv /usr/local/obm /usr/local/obm.bak 

d. Expand the new client software to $OBM_HOME 
 
# cd $OBM_HOME 
# tar xvfz obm-linux.tar.gz  
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e. Start backup scheduler by running $OBM_HOME\bin\Scheduler.sh 

f. You can then open AhsayOBM by running $OBM_HOME\bin\BackupManager.sh 

2.3 Un-installation 
This section describes the steps required to uninstall AhsayOBM from your computer. 

Uninstallation instructions of AhsayOBM on Windows 

a. Open [Start] -> [Control Panel]  -> [Add/Remove Programs] 

b. Select [AhsayOBM] from the list and press the [Remove] button 

Uninstallation instructions of AhsayOBM on Netware 

a. Stop running backup scheduler by running 
 
SYS:\> touch SYS:\OBM\ipc\Scheduler\stop 

b. Remove all program files by removing the directory SYS:\OBM 

c. Remove all backup settings by removing the directory SYS:\.OBM 

Uninstallation instructions of AhsayOBM on Mac OS X 

a. Stop running backup scheduler by running 
 
# SystemStarter AhsayOBM stop 

b. Remove all program files by removing /Applications/OBM  
 
# rm –rf /Applications/OBM  

c. Remove all backup setting by removing ~/.obm 
 
# rm –rf ~/.obm  

d. Remove backup scheduler service from system startup by 
/System/Library/StartupItems/AhsayOBM  
 
# rm –rf /System/Library/StartupItems/AhsayOBM 

Uninstallation instructions of AhsayOBM on Linux 

a. Stop running backup scheduler by running 
 
# touch $OBM_HOME/ipc/Scheduler/stop 

b. Remove all program files by removing $OBM_HOME 
 
# rm –rf $OBM_HOME 

c. Remove all backup setting by removing ~/.obm 
 
# rm –rf ~/.obm 

Uninstallation instructions of AhsayOBM on Sun Solaris 

a. Stop running backup scheduler by running 
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# touch $OBM_HOME/ipc/Scheduler/stop 

b. Remove all program files by removing $OBM_HOME 
 
# rm –rf $OBM_HOME 

c. Remove all backup setting by removing ~/.obm 
 
# rm –rf ~/.obm 

2.4 AutoStartup on Linux 
Please follow the instructions below to make AhsayOBM scheduler auto startup upon computer restart.  

i. Copy the startup script of AhsayOBM scheduler (obm-scheduler) to Linux startup script directory 
(/etc/rc.d/init.d) 
 
 [root]# cp $OBM_HOME/bin/obm-scheduler /etc/rc.d/init.d 

ii. Open /etc/rc.d/init.d/obm-scheduler with VI editor and make changes to the OBM_HOME 
environment variable export statement (i.e. export OBM_HOME=/usr/local/obm) if OBM_HOME is 
not /usr/local/obm 

iii. Register the obm-scheduler startup script as system service by 
 
 [root]# chkconfig --add obm-scheduler 

iv. To startup AhsayOBM scheduler, please run 
 
 [root]# service obm-scheduler start 

v. (optional) To shutdown AhsayOBM scheduler, please run 
 
 [root]# service obm-scheduler stop 

vi. Setup completed 
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3 Using AhsayOBM 
This chapter will describe all features available in AhsayOBM and outline how you can use the features of 
AhsayOBM to meet various backup needs.  

3.1 System Tray Launcher 
After you have successfully installed AhsayOBM to your computer, an OBM icon will be added to the system tray 
area (next to your system clock) automatically.  

 

This icon is the entry point to AhsayOBM. Right clicking the icon will show a menu that provides the following 
functions: 

Menu Item What it does 

Open Run AhsayOBM 

Backup Run the backup set (or all backup sets) chosen in the sub-menu in 
background 

Backup and Logoff Run the backup set (or all backup sets) chosen in the sub-menu in 
background and logoff from Windows 

Backup and Restart Run the backup set (or all backup sets) chosen in the sub-menu in 
background and restart Windows 

Backup and Shutdown Run the backup set (or all backup sets) chosen in the sub-menu in 
background and shutdown this computer 

Help Show a help dialog 

Stop running backup Interrupt the running backup set (or all backup sets) chosen in the sub-
menu 

Exit Close this system tray launcher application 

 
3.2 Logon Dialog 
Before you can use AhsayOBM, you have to be authenticated by the Ahsay Offsite Backup Server first. The logon 
dialog shown below will check if you have the right to access AhsayOBM by submitting the username and 
password you provided to the backup server. 
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For secure communication, you can choose to communicate with Ahsay Offsite Backup Server in SSL (Secure 
Socket Layer) by selecting the [https] option.  

The [Address] field shows the Ahsay Offsite Backup Server to which AhsayOBM will connect to authenticate your 
username and password. You can use either a resolvable host name (e.g. backup.your-domain.com) or an IP 
address (e.g. 192.168.1.1).  
 
If the Ahsay Offsite Backup Server is not accepting connection from the standard ports (Port 80 and 443 for http 
and https respectively), you can append a semi-colon “:” and your custom port number to the host name of the 
[Address] field (e.g. www.backup-provider.com:8080) to connect to the server using the custom port number 
(port 8080 in this case).  

If you need to connect to the server through proxy, just enter your proxy setting in the [Proxy Setting] section. 
For [SOCKS] proxy, both v4 and v5 without user authentication are supported. 

3.3 Language Selection 
You can switch the language of the AhsayOBM user interface by choosing the desired language available from the 
[Language] drop down list. The languages available include English, Czech, Danish, German, Spanish, Icelandic, 
Dutch, Swedish, Traditional Chinese and Simplified Chinese.  
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3.4 User Profile 
After the backup server authenticates you successfully, AhsayOBM main window appears. You can then use 
AhsayOBM to update your user profile. 

 

You can perform the following update to your user profile. 

To change your [Password], press the [Change] button next to the password field. A Change Password dialog will 
appear. Enter your original password and new password into the text field of this dialog and press [OK].  
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To change your [Display Name], press the [Change] button next to the display name field. A Change Display 
Name dialog will appear. Enter the new display name and press [OK].  
 

 

To change your [Time Zone], just select your time zone from the drop down list next to the time zone entry.  

To add a new contact email to this account, press the [Add] button in the [Contact] section. A [Add New Contact] 
dialog will appear. Enter a name and an email address in the text field provided and then press the [OK] button. 
 

 

To remove a contact email, select the email that is to be removed from the email list and press the [Remove] 
button. Press [OK] to confirm the removal. 

To update a contact email, select the email that is to be updated from the email list and press the [Properties] 
button. A [Update Contact Property] dialog will appear. After you have made the changes that you want, press the 
[OK] button. 
 

 

3.5 Backup Logs 
All backup activities are logged to backup activity log files. They are available for reviewing from AhsayOBM. 

How to review backup activities? 

You can review all your backup jobs by  

i. Select the [Log] tab available at the bottom of AhsayOBM 

ii. Select the Backup Job you want to review on the [Log Controller] panel 
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4 Setting up backup set 
A backup set contains all backup settings of a backup operation. This section will describe all features available 
within a backup set and explain how you can use each of them to achieve various tasks.  

Each backup account can have multiple backup sets. Each backup set is an individual and independent entity. For 
example, if you want one directory to be backed up during the day and another directory to be backed up during 
the night, you can create two backup sets, each with a different backup schedule and backup source, to serve this 
need.  

4.1 Backup Set Type 
A backup set can be of one of the following types: 

Backup Type Description 

File  Backup set type to backup common files/directories 

Microsoft SQL Server Backup set type to backup Microsoft SQL Server 7.0/2000 

Oracle Database Server Backup set type to backup Oracle 8i/9i database 

Lotus Domino/Notes Backup set type to backup Lotus Domino/Notes  

Microsoft Exchange Server Backup set type to backup Microsoft Exchange Server 2000 / 2003  

MySQL Backup set type to backup MySQL Server 
 

Backup set type is defined at backup set creation and cannot be modified. If you want to change the backup set 
type, you have to create another backup set.  

 

4.2 Backup Source 
A backup source defines the files/directories that are to be included in a backup set. There are two types of 
backup source: Selected and Deselected. Selected backup source defines files/directories that are to be included in 
a backup set while deselected backup source defines files/directories that are to be excluded from a backup set. 
Online Backup Manager will generate appropriate backup source setting for you automatically when you make 
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your backup source selection on AhsayOBM. 

From the [Standard] node available at the top of the [Backup Source] tree, you can easily select the following 
common folders to be backed up: 

1. “My Documents” folder 

2. “Outlook” and “Outlook Express” mail store folder 

3. “Favorites” folder 

4. “Desktop” folder  

From the [Options] node available below the [Standard] node, you can easily select other common folders to be 
backed up as well. They include the “Application Data” folder, the “Start Menu” folder, the “Templates” folder, the 
“All Users’ Documents” folder, the “Temporary Internet Files” folder, the “Cookies” folder, the “Font” folder, the 
“History” folder, the “Applications Data” folder, the “Nethood” folder, the “Printhood” folder, the “Recent” folder 
and the “Send to” folder. 

 

The checkbox next to the files/directories shown above can be in one of the following mode: 

Mode Description 

 All files/directories (recursively) under this directory will be backed up 

 All files/directories (recursively), except those explicitly excluded, under this directory will 
be backed up. If you add files/directories to this directory in the future, they will be 
backed up as well. 

 Only the checked files/directories under this directory will be backed up. If you add 
files/directories to this directory in the future, they will NOT be backed up. 

 Nothing under this directory will be backed up. 
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4.3 Backup Schedule 
A backup schedule defines the frequency and the time backup will run automatically. 

 

Backup schedule can be in one of the following types: 

Type Description 

Daily Backup jobs will run everyday 

Weekly Backup jobs will run on the specified day(s) of every week 

Monthly Backup jobs will run on the specified day or on a day with a given criteria (e.g. first 
weekend, last weekday) of every month 

Custom Backup job will run once on any particular date 
 
For each type of schedule above, backup will run at scheduled time for a maximum of the duration specified (or 
until all data are backed up if [Stop on backup completion] option is chosen). If a backup job does not finish within 
the maximum duration specified, it will be interrupted. 

Please note that you can have more than one schedule within a backup set. For example, you can have a daily 
backup schedule that runs at 13:00 at noon and another daily backup schedule that runs at 00:00 at midnight. 
The combination of both of these schedules effectively creates a backup schedule that runs daily at 00:00 and 
13:00 everyday. 

4.4 In-File Delta 
Please refer to the in-file delta section for more information on this topic.  

4.5 Backup Filter 
A backup filter defines the file selection rules that allow user to easily include/exclude files into/from the backup 
set by applying user defined criteria(s) to the file names or directory names. 
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There are some basic rule regarding backup filters: 

i. Filters are checked in creation order. Once inclusion/exclusion has been identified, the remaining 
filters won't be checked. 

ii. Inclusion/Exclusion made by filter always takes precedence over backup source selections 

iii. If all filters do not apply to a particular file, this file is then checked for inclusion/exclusion backup 
source selections 

 

Key Description 

Name The name of a filter 

Top Directory The top directory to which this filter is applied. Filtering rules will be applied to 
all files and/or directories under this directory. 

Apply To Define whether to apply the filtering rule to files and/or directories 

Pattern Matching It defines the filtering rules of a filter. A filtering rule can be of one of the 
following types: 
 
[Start With] Include/Exclude all files/directories with name starting 

with a certain pattern.  
For example: You can use B* to match all files with 
name starting with a ‘B’ character 

 
[Contain] Include/Exclude all files/directories with name 

containing a certain pattern.  
For example: You can use *B* to match all files with 
name containing with a ‘B’ character 

 
[End With] Include/Exclude all files/directories with name ending 

with a certain pattern.  
For example: You can use *.doc to match all files with 
name ending with ‘.doc’ (all Word documents) 

 
[Regular Expression] Include/Exclude all files/directories with name matching 
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a regular expression.  
 

Filter Mode Defines whether you want to include or exclude matched files into/from the 
backup set. Also, for those unmatched files, you can choose to exclude (if 
include filter type) or include (if exclude filter type) them into/from the backup 
set.  

 
Example 1: 
If you want to backup only Word, Excel and PowerPoint documents in your document directory (e.g. C:\My 
Documents), you should setup your backup filter as follows. 

Top Directory  = C:\My Documents  
Apply To   = File (true) 
Matching Type = End With 
Matching Patterns = *.doc, *.xls, *.ppt 
Filter Mode  = Include 
Exclude all others  = True 

Example 2: 
If you want to backup all files, excluding all *.exe, *.dll and *.tmp, in C:\Applications, you should setup your 
backup filter as follows. 

Top Directory  = C:\Applications 
Apply To   = File (true) 
Matching Type = End With 
Matching Patterns = *.exe,*.dll, *.tmp 
Filter Mode  = Exclude 
Include all others  = True 

Example 3: 
If you have made your selection of files (all under C:\) from the backup source setting but you want exclude all 
images (e.g. *.jpg and *.gif) from your selection, you should setup your backup filter as follows. 

Top Directory  = C:\  
Apply To   = File (true) 
Matching Type = End With 
Matching Patterns = *.jpg, *.gif 
Filter Mode  = Exclude 
Include all others  = false 

Please note that the [Include all others] setting is not enabled because you don’t want to include all other files 
(NOT *.jpg, *.gif) under C:\ into the backup set. 

Example 4: (advanced) 

If you want to include everything, except the “log” directory, under C:\Applications into a backup set, you should 
setup your backup filter as follows. 

Top Directory  = C:\Applications 
Apply To   = Directory (true) 
Matching Type = Regular Expression  
Matching Patterns = ^log$ 
Filter Mode  = Exclude 
Include all others  = True 

Example 5: (advanced) 

If you want to include all directories named “log” from the backup set files with file name starting with “B” and 
ending with “*.doc” under C:\My Documents into the backup set, you can use a regular expression of 
“^B.*\.doc$” to do your selection. The filter backup can then be setup as follows. 

Top Directory  = C:\My Documents 
Apply To   = File (true) 
Matching Type = Regular Expression  
Matching Patterns = ^B.*\.doc$ 
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Filter Mode  = Include 
Exclude all others  = True 

4.6 Pre/Post-Backup Command 
The command line tool feature has two major components, the [Pre-Backup] command and the [Post-Backup] 
command. You can use the [Pre-Backup] or [Post-Backup] commands to run any native OS (operating system) 
commands before or after running a backup job.  

 

Both [Pre-Backup] and [Post-Backup] commands comprise of the following parameters:  

Key Description 

Name  Name of this Command 

Command The command to be run  
(e.g. C:\My Documents\Application.exe or C:\My Documents\BatchJob.bat) 

Working Directory The directory at which this command will run 
 
The backup set type affects the time at which [Pre-Backup] and [Post-Backup] commands run. The following table 
outlines when [Pre-Backup] and [Post-Backup] commands will run in different types of backup set. 

Backup Set Type When Pre-Backup Commands run?  When Post-Commands run? 

File  Before uploading backup files After uploading all backup files 

Non-File Backup Sets 
(e.g. Microsoft SQL 
Server) 

Before spooling backup files to 
temporary directory 

After spooling backup files to 
temporary directory (i.e. before 
the first backup file is uploaded) 

 
Note: You should never backup an application while it is running as this can result in inconsistent and unusable 
files getting backed up. Please use the Pre-Backup Command feature to shutdown your application before running 
a backup job and use the Post-Backup Command feature to restart your application after the backup job has 
completed. 

4.7 Encryption 
Before your files are sent to Ahsay Offsite Backup Server, all your files are to be compressed and encrypted by 
your choice of encrypting algorithm, mode and key. The following table explains all encryption parameters 
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available within a backup set. 

Note: 
Encryption settings are set at backup set creation time and cannot be modified. You need to create a new backup 
set if you want to change your encryption settings for a backup set. 

 

Parameter Description 

Encryption Algorithm It defines the encrypting algorithm used to encrypt your backup files. 
There are three encryption algorithms available:  
 
[AES] Advanced Encryption Standard algorithm 
[DESede] Triple DES algorithm 
[Twofish] Twofish algorithm 
 
We recommend the use of AES as it has been chosen as the encryption 
standard for commercial use. Please refer to references on Cryptography 
for more information on this area. 

Encryption Mode It defines the encrypting mode used to encrypt your backup files. There 
are two encryption modes available:  
 
[ECB] Electronic Cook Book Mode 
[CBC] Cipher Block Chaining Mode 

 
We recommend the use of CBC mode as it offers better security. Please 
refer to references on Cryptography for more information on this area. 

Encrypting Key The key used to encrypt all files within a backup set. Please write it 
down on paper and keep it in a safe place. If the key is lost, you 
will not be able to recover your files from the encrypted backup 
files. 

  

4.8 Retention Policy 
During backup, if AhsayOBM finds out that you have deleted a file (or updated a file) on your computer, it will put 
the corresponding deleted (or updated) file already backed up on the backup server into a retention area. The 
retention policy setting defines how long files inside the retention area will be kept on the backup server before 
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they are deleted automatically from the server. 

Retention policy will only affect “retained” file (i.e. files that have already been deleted or updated on your 
computer and thus are moved to the retention area of the backup server). For those files that have not been 
updated on your computer, the backup of these files is kept in the data area on the backup server and won’t be 
affected by the setting of retention policy. These backup files of unchanged files will stay on the backup server 
forever until the original files are removed (or updated) from your computer. 

Standard Retention Policy 

The [Standard] retention policy allows you to delete retained files automatically after a user defined number of 
days or after a user defined number of backup jobs. To change the retention policy setting of any backup set, 
please select the [Retention Policy] node on the left panel. You can then make changes to your retention policy 
under the [Retention Policy] section. After you have made your changes, just press the [Save Setting] button on 
the toolbar. 
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Advanced Retention Policy 

 
 

The [Advanced] retention policy allows you to configure a more flexible retention policy. It allows you to keep a 
set of snapshots of all backup files based on the time of the backup jobs. For example, you can configure the 
advanced retention policy to keep the following sets of backup files to mimic the retention policy back from the old 
days when you were still doing tape rotations: 

� All files available within the last 7 days 

� All files available on the last 4 Sundays within the last 28 days 

� All files available on the 1st day of each month within the last 3 months 

� All files available on the 1st day of each quarter within the last 12 months 

� All files available on the 1st day of each year within the last 7 years 

To do so, you need to setup your advanced retention policy as follows:  

� Type = Daily; Number of copy to keep = 7  

� Type = Weekly; Frequency = Sunday; Number of copy to keep = 4 

� Type = Monthly; Frequency = Day 1; Number of copy to keep = 3 

� Type = Quarterly; Frequency = Day 1 of Jan, Apr, Jul, Oct; Number of copy to keep = 4 

� Type = Yearly; Frequency = Date 01-01; Number of copy to keep = 7 

Assuming today is 17-Jan-2006, if [Remove retention files for overlap policy] is NOT enabled, a total of 25 
snapshots (7+4+3+4+7, provided you have run backup daily for more than 7 years already) will be kept on the 
server accordingly, i.e.:  
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� Daily: 10-Jan-2006, 11-Jan-2006, 12-Jan-2006, 13-Jan-2006, 14-Jan-2006, 15-Jan-2006, 16Jan-2006 

� Weekly: 24-Dec-2005, 31-Dec-2005, 7-Jan-2006, 14-Jan-2006 

� Monthly: 1-Nov-2005, 1-Dec-2005, 1-Jan-2006 

� Quarterly: 1-Jan-2005, 1-Apr-2005, 1-Jul-2005, 1-Oct-2005 

� Yearly: 1-Jan-2004, 1-Jan-2003, 1-Jan-2002, 1-Jan-2001, 1-Jan-2000, 1-Jan-1999 

If [Remove retention files for overlap policy] is enabled, only the following snapshots are kept: 

� Daily: 14-Jan-2006, 15-Jan-2006, 16-Jan-2006 

� Weekly: 7-Jan-2006 

� Monthly: 1-Nov-2005, 1-Dec-2005, 1-Jan-2006 

� Quarterly: 1-Jan-2005, 1-Apr-2005, 1-Jul-2005, 1-Oct-2005 

� Yearly: 1-Jan-2004, 1-Jan-2003, 1-Jan-2002, 1-Jan-2001, 1-Jan-2000, 1-Jan-1999 

The weekly policy overrides the daily policy so the snapshots of 10-Jan-2006, 11-Jan-2006, 12-Jan-2006 and 13-
Jan-2006 are removed. The monthly policy overrides the weekly policy so the snapshots of 24-Dec-2005, 31-Dec-
2005 and 7-Jan-2006 are removed as well. The same applies to the quarterly and yearly policy but because there 
is no other overlapping of the dates above, the snapshots of dates specified by the monthly, quarterly and yearly 
policy remains the same. 

4.9 Extra Backup (Off-line backup, Logout Reminder) 
Off-line backup is basically designed for notebook users who are off-line most of the time and cannot rely on 
backup schedule to backup regularly. The "Backup Interval" allows notebook users to specify the interval that they 
would like their data to backup. If this interval has elapsed, backup will run automatically once this machine is 
online. The "Off-line Notification Day" setting is the number of days after the off-line backup interval when the 
backup server will send email notification to the client to remind him to run an off-line backup. 

4.10 Network Mapped Drive 
If you need to backup a network-mapped drive on Windows (it will only work in Windows NT/2000/XP/2003), you 
must enter your Windows domain, username and password into the [Network Resources Authentication for 
Windows] section as shown below. It is required because scheduled backups will always run under the context of 
windows LocalSystem account (which does not have the privilege required to access network resources) by default. 
AhsayOBM need to collect your Windows username, password and domain name to authenticate itself to the 
windows domain controller to acquire the required access privileges to the network files which are to be backed up. 
If you don’t supply a username and password, AhsayOBM will have problem accessing network resources in its 
scheduled backup jobs. 

If you need to backup network mapped drive in scheduled backup, please do this: 

i. Select the backup set from the left panel and press the [Properties] button  
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ii. Enter your Windows domain, username and password into the dialog shown below 
 

 

iii. Press the [Save Setting] button on the toolbar 
 

The steps above apply only to computers running in a Windows domain. If you don’t have a windows domain with 
your network and you are using a workgroup or using a NetWare server instead, please use the “net use” 
command to authenticate the running backup process against the computer hosting the mapped drive. Otherwise, 
you will get “Access Denied” error from the backup report. 

For example, if you want to backup \\SERVER\SHARE that is located on a NetWare server (or another computer is 
a windows workgroup) and you are getting "Network drive is not accessible" error message, please try adding the 
following command as a [Pre-backup command]  

net use \\SERVER\SHARE [PASSWORD] /USER:[DOMAIN | MACHINE_NAME]\[USERNAME] 

E.g. 

C:\> net use \\Netware\Data password /USER:peter 
C:\> net use \\WorkgroupComputer1\Data password /USER:WorkgroupComputer1\peter 

This will authenticate the current process with the NetWare server (or another computer is a windows workgroup). 
Backup will then be allowed to run correctly. 
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4.11 Local Copy 
If you want to save an extra copy of backup data on your local disk (in addition to a copy of backup data stored 
on the backup server) to minimize file-restoring time and/or to provide an extra safety precaution, you can do the 
following: 

i. Open AhsayOBM from the System Tray (see previous sections for details) 

ii. Setup your backup set (see previous sections for details) 

iii. Select [Local Copy] under your backup set from the left panel  
 

 

iv. Check the [Copy to Local Hard Disk] checkbox 

v. Enter a directory to where you want an extra copy of your backup files to be stored in the [Copy to] 
field provided (preferably a directory under another hard disk) 

vi. (Optional) Select the [Yes] radio button if you want to store your backup files in compressed form 
to conserve free space usage 

vii. An extra copy of backup will be saved in the [Copy to] directory when you run your backup job  
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If you want to make local copy to a directory located on a NetWare server (or another computer is a windows 
workgroup) and you are getting "Network drive is not accessible" error message, please try adding the following 
command as a [Pre-backup command]  

net use \\SERVER\SHARE [PASSWORD] /USER:[DOMAIN | MACHINE_NAME]\[USERNAME] 

E.g. 

C:\> net use \\Netware\Data password /USER:peter 
C:\> net use \\WorkgroupComputer1\Data password /USER:WorkgroupComputer1\peter 

This will authenticate the current process with the NetWare server (or another computer is a windows workgroup). 
Backup will then be allowed to run correctly. 

How to restore “Local Copy” files 

“Local copy” files are stored in the [Copy to] directory (under [Local Copy] setting) in encoded filenames (A 
“.nozip” extension is appended to all filenames if [Zip] setting is not enabled. A “.zip” extension is appended to all 
filenames if [Zip] is enabled). To restore backup files back to their original filenames (and to their original contents 
if [Zip] is enabled), please do the followings: 

i. Choose [Tools] -> [Unzip Local Copy] 
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ii. Select the required [Backup Set] from the drop down list 
 

 

iii. Fill in the [Source Directory] (directory where “Local Copy” files are stored) and [Destination 
Directory] (directory to where you want “Local Copy” files to be restored) 

iv. Completed 
 

4.12 Multiple Computers using one backup account 
If you want to backup multiple computers using a single backup account, you need to create different backup sets 
to backup each individual computer. Also, for each installed copy of AhsayOBM, you must configure AhsayOBM so 
that it only runs scheduled backup for its intended backup sets on its computer. If this is not being setup properly, 
scheduled backup job of the same backup set from different computers will both be started. This will result in lots 
of checksum errors and files being deleted on the backup server. 
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To allow multiple computers to be backed up under a single backup account, you are required to do the following 
for each computer that has been installed with AhsayOBM under the same backup account: 

i. Logon to one of the computers that has been installed with AhsayOBM under the same backup 
account 

ii. Open AhsayOBM and select a backup set that is not intended to run on this computer from the left 
panel 

iii. Uncheck the [Run scheduled backup on this computer] checkbox on the right panel 
 

 

iv. Repeat the previous step for the rest of all backup sets that are not intended to run on this 
computer 

v. Repeat step ii to step iv for each computer that has been installed with AhsayOBM under the same 
backup account 

IMPORTANT If you want to backup an extra computer using the same backup account some time later (this 
implies that you need to create an additional backup set under this backup account for the new computer), please 
make sure to repeat the procedure above (unchecking the [Run scheduled backup on this computer] checkbox for 
the added backup set) for each computer 

4.13 Transfer Block Size 
Transfer block size defines the block size AhsayOBM will use to transfer your backup blocks. Generally, backup job 
using a larger block size would have a better performance, as there will be less roundtrip involved in connection 
initialization.  

However, some firewalls or proxy servers may block out-going network traffic (HTTP/HTTPS POST method) with 
large block size for security reasons. If you are in a network with this type of restriction, please lower the transfer 
size value and try again. 

To change the transfer block size of any backup set, please select the [Setting] node on the left panel to invoke 
the [Setting] panel on the right. You can then make changes to the [Transfer Block Size]. After you have made 
your changes, just press the [Save Setting] button on the toolbar. 

 



committed to the success of your business 
Ahsay Offsite Backup Server v5.1

User’s Guide
 

 

Leb Shama Company Limited Page 35 of 120 (June 16, 2006)
 

 

4.14 Temporary directory 
If you are running a file backup job with in-file delta enabled or a database type backup job, temporary files will 
be generated by the backup job and directory that will be used to store all these files are defined by [Setting] -> 
[Temporary directory for storing backup files]. Please set this to a non-system disk partition that has enough free 
space to avoid problems. 

You can set the [Temporary directory for storing backup files] to a network mapped drive. If you choose to do this, 
please use a UNC path (e.g. \\SERVER\SHARE) or don’t forget to configure the [Backup Set] -> [Network 
Resources Authentication for Windows] setting. 

To conserve the use of disk space, you can use the [Remove temporary files after backup] option to delete the 
temporary files automatically after a backup job has finished. 

 



committed to the success of your business 
Ahsay Offsite Backup Server v5.1

User’s Guide
 

 

Leb Shama Company Limited Page 36 of 120 (June 16, 2006)
 

 

 
4.15 Follow Symbolic Link (Linux/Unix/Mac only) 
Under Unix/Linux, users can use symbolic link to create a simple link to a directory from another directory. This 
setting defines whether you want AhsayOBM to traverse any symbolic links encountered on your backup path. 

To change the transfer block size of any backup set, please select the [Setting] node on the left panel to invoke 
the [Setting] panel on the right. You can then make changes to the [Follow Symbolic Link]. After you have made 
your changes, just press the [Save Setting] button on the toolbar. 
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4.16 Microsoft Volume Shadow Copy (VSS) 
Microsoft Volume Shadow Copy Service (VSS) allow you to backup files that are exclusively opened. Without VSS, 
you will get the error message “The process cannot access the file because another process has locked a portion of 
the file” if you are trying to backup a file that is exclusively opened (e.g. Outlook PST file).  

Please note that VSS is only available on Windows XP / 2003 and you must have administrative privileges to start 
the VSS service on a computer. 

If you are running Windows 2003, please install the Windows 2003 VSS hot fix available in 
http://support.microsoft.com/default.aspx?scid=kb;en-us;887827 before running VSS. 

If you are running into problem with running VSS on Windows XP, Microsoft's recommendation is to try re-
registering the Volume Shadow Copy Service again. Simply run the script [AhsayOBM Home]\bin\RegisterVSS.bat 
to do so. 

For more information, please take a look at the following page for a technical introduction to Volume Shadow Copy 
Services (VSS): 

http://technet2.microsoft.com/windowsserver/en/library/2b0d2457-b7d8-42c3-b6c9-59c145b7765f1033.mspx 

 

http://support.microsoft.com/default.aspx?scid=kb;en-us;887827
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5 Backing up files 
This chapter describes how files are backed up by AhsayOBM to the backup server 

5.1 How files are backed up 
The diagram below describes how AhsayOBM backup your files. 

 

 
Run backup at scheduled time automatically 

Once you set your backup scheduled, a backup job will be started automatically to perform backup operation for 
you at your absence. You can have backup running at your scheduled time as often as you want (e.g. twice a day 
or hourly during office hour) without requiring doing any extra work. 

Incremental Backup 

Unchanged files are already backed up to server and need not to be backed up again. AhsayOBM will pick the new 
or updated files from your backup set files and upload only these files to the server. It significantly reduces the 
time required to perform the backup operation since most users update less than 5% of their total data each day. 

Compress and encrypt data automatically 

Data are compressed and encrypted before they are uploaded to the server. Not only does it reduce the storage 
space to keep you backup files, it also ensures the privacy of your data. 

File Retention Policy 

The built-in file retention policy allows you to access multiple versions of the same file or even deleted files from 
your backup set. Backup files are put into a retention area before they are removed from the server. If you want 
to get back a deleted file (or you want to get back the previous versions of an updated files) within the retention 
period, these files will always be available in the retention area. This feature is particularly useful when you have 
accidentally deleted a file or incorrectly updated a file within the file retention period (file retention period is user 
customizable).  
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5.2 Backup files directly to the backup server 
You can backup your data to an Ahsay Offsite Backup Server by following instructions below. 

i. Open AhsayOBM 

ii. Right click AhsayOBM icon available in the system tray and choose [Open] 

a. Create a backup set 

b. From the Menu, Choose [Backup Set] -> [New] -> [File Backup Set] 
 

 

c. Enter a name for your backup set 
 

 

d. Select the files/directories you want to backup 
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e. Set the backup schedule (Note: You can have more than one schedule in a backup set) 
 

 

f. Set the encryption algorithm, encryption mode and encrypting key for this backup set 
(Hint: For the sake of simplicity, just select the [Default] radio button (your encrypting key is 
set to be the same as your backup account password) 
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iii. Run Backup  

a. Select the backup set you want to run on the left panel and press the [Start Backup] button 
(►) on the toolbar 

b. Select [Off-site Backup Server] to start backing up your files to an Ahsay Offsite Backup 
Server. 
 

 

Note:  
1. You can have more than one backup set in backup account. 
2. Please write the encrypting key down on paper and keep it in a safe place. If you lost your encrypting key is 

lost, you will not be able to restore your backup files. 
 

5.3 Backup files to removable hard disk (seed loading) 
If you have a lot of data (e.g. 300GB) to backup to the backup server, it would take a considerable amount of 
time to perform the first full backup through the Internet. If you run into this problem, you can use the Seed 
Loading Utility to backup your backup set to local hard disk (instead of directly to the backup server) and then 
transport the backup data, using removable hard disk, to the offsite backup server. The administrator can then 
load all your backup files from your removable hard disk into your backup account. This could then save you days 
(even weeks) of performing your first full backup. Since subsequent backup will be incremental backup (only new 
or updated files will be uploaded to the server), you should have no problems finishing backing up all files 
afterwards.  

To perform seeding loading, please do the following: 

i. Open AhsayOBM from the System Tray (see previous sections for details) 
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ii. Setup your backup set (see previous sections for details) 

iii. Select the backup set you want to run on the left panel and press the [Start Backup] button (►) 
on the toolbar 

iv. Select [Local Hard Disk (Seed Load Utility)] to start backing up your files to local hard disk and 
press the [OK] button 
 

 

v. Enter a directory where you want all backup files to be stored in the [Destination Directory] field 
and press the [Start] button.  
 
Please make sure you have enough free space in the directory specified. If you are going to 
transport a removable hard disk to the offsite backup server, please enter a directory under your 
removable hard disk here. 
 

 

vi. You should get the message “Backup Completed Successfully” as shown below after all backup 
files are spooled to the directory you specified.  
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vii. Transport the data specified in the [Destination Directory] field to the offsite backup server 
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6 Restoring files 
This chapter describes different ways files can be restored from to the backup server 

It is important to write down your encrypting key on paper and keep it in a safe place 
because there will be no ways to restore your backup files if you lose your encrypting 
key. 

 

6.1 Restore backup files directly from backup server 
You can use either AhsayOBM or the web restorer to restore backup files from the backup server. 

Using AhsayOBM 

You can restore your data from the backup server Ahsay by following instructions below. 

i. Open AhsayOBM from the System Tray (see previous sections for details) 

ii. Select the [Restore] tab at the bottom part of AhsayOBM  
 

 

iii. Select the backup set from which you would like files to be restored from the left panel 

iv. Select the snapshot of your backup files that you would like to restore from the backup server by 
using [Show files after Job] drop down list 

v. Select the files that you would like to restore and press the [Restore Files] button on the toolbar 
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vi. Use the [Browse] button to select the directory to where you want files to be restored (or simply 
select [Original location] to restore files to their original path) 

vii. Files will be restored automatically as shown below (a file won’t be downloaded from the backup 
server again if an identical file exists on local path already) 
 

 

 

Using the web interface 

You can backup your data to an Ahsay Offsite Backup Server by following instructions below. 

i. Logon to the Ahsay Offsite Backup Server web interface 

ii. From the top menu, click [File Explorer]  
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iii. Click the [Backup Set] link that contains the files that you want to restore 

iv. Select the snapshot of your backup files that you would like to restore from the backup server by 
using [Show files after Job] drop down list 
 

 

v. If you want to see all different versions all files (shown as gray below), just choose the [Show all 
files] radio button on the [File Explorer] page.  
 
Files, which are shown in gray and marked as deleted below, e.g. dell.img (delete), are being 
stored in the retention area on the backup server but you can still restore these files from the 
backup server. 
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vi. Select the files that you would like to restore and press the [Restore] button on the toolbar 

vii. A dialog shown below would appear 
 

 

a. Press the [Restore] button  

b. Enter the directories to which backup files should be restored in the [Restore File to] textbox  
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c. Enter the encrypting key which will be used to decrypt your backup files upon restoring your 
backup files 

d. Press the [Start] button 

 
6.2 Restore backup files from removable hard disk 
If you want to restore lots of backup files from the backup server and you find it too slow to restore all your 
backup files from the backup server through the internet. You can ask your backup services provider to send you 
all your backup files in removable hard disk (or CD/DVD). However, all backup files stored on backup server are in 
encrypted format. You need to decrypt them back to their original format before you can use them. To decrypt 
your backup files from removable media, please do the followings: 

i. Open AhsayOBM from the System Tray  

ii. Select the [Tools] -> [Decrypt Files Wizard] from the menu 
 

 



committed to the success of your business 
Ahsay Offsite Backup Server v5.1

User’s Guide
 

 

Leb Shama Company Limited Page 49 of 120 (June 16, 2006)
 

 

iii. Use the [Browse] button to locate the “files” directory (provided by your backup provider in 
removable hard disk or DVD) which contains the backup files that you want to decrypt  
 

 

iv. If you have more than one backup set under the “files” directory, select the [Backup Set] which 
contains the backup files that you want to decrypt  
 

 



committed to the success of your business 
Ahsay Offsite Backup Server v5.1

User’s Guide
 

 

Leb Shama Company Limited Page 50 of 120 (June 16, 2006)
 

 

v. Select the snapshot of your backup files that you would like to restore from the removable media 
by using [Show files after Job] drop down list 
 

 

vi. If you want to see all different versions all files (shown as gray below), just choose the [Show all 
files] radio button on the [Decrypt Files Wizard] dialog.  
 
Files, which are shown in gray and marked as deleted below, e.g. dell.img (delete), are being 
stored in the retention area on the removable media (but you can still restore these files). 
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vii. Enter the directories to which you want backup files to be restored in the [Decrypt Files to] section 
and enter the [Decrypting Key] (the same as the encrypting key of this backup set) 
 

 

viii. Press the [Start] button 
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6.3 Restrict restoring files by IP addresses  
Online file restoring operation can be restricted by IP addresses. You can ask your backup provider to restrict 
online file restoring for your backup sets by IP addresses to allow people from authorized IP addresses to restore 
files from the backup server. To check if online file restore of any backup set is restricted this way, please take a 
look at the web interface of AhsayOBS, [Online Backup Services Management Console] -> [Backup Set] -> [Online 
Restore IP restriction] (shown below). 

Users are not allowed to update the [Online Restore IP restriction] directly. Please ask your backup services 
provider to do the changes for you. 
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7 In-File Delta Technology 
The chapter describes what in-file delta technology is and how in-file delta can be used to backup large database 
files (e.g. a 10GB Outlook.pst file) without uploading the whole database file everyday. 

7.1 Overview 
In-file delta technology is an advanced data block matching algorithm which has the intelligence to pick up 
changes (delta) of file content between two files when one of the files is not accessible and use the delta 
information between two files to rebuild one file from the other. Using this algorithm, daily backing up of large file 
(e.g. a 10GB Outlook.pst file) over low-speed internet connection is made possible because it requires only the 
changes of information (should be marginal) since last backup (or last incremental backup) to be sent over a low-
speed internet connection to complete the backup of a large file (here we assume that the full backup of the file 
has been saved on the backup server already).  

This is what would happen to the backup of a 10GB Outlook.pst file when it is backed up by AhsayOBM with in-file 
delta technology. 

i. The whole files (10GB), along with its checksum (128-bit) file, are backed up to the backup server. 
This can be done directly through the internet or indirectly using the seed loading utility on a 
removable hard disk. 

ii. When backup runs again later (normally the next day), AhsayOBM will download a checksum 
listing of all data blocks of the full backup file (or last incremental backup file) from the backup 
server and use it to pick up all changes that have been made to the current Outlook.pst file from 
the first full backup. 

iii. Changes detected are then saved in a delta file which is uploaded to the backup server. (This delta 
file is assumed to be small because the content of all PST files doesn’t change lot of even after it 
has been updated)  

iv. Subsequent backups of this 10GB Outlook.pst file will go through step ii and step iii again. As 
explained, only a small delta file will be uploaded to the backup server. 

v. With in-file delta technology, daily backing up of large file over low-speed internet connection is 
now possible 

Incremental in-file delta type 

Example 1: If you are adding 200MB to Outlook.pst everyday, everyday after the first full backup job, AhsayOBM 
will detect what has been added since last daily backup and upload only 200MB of delta file to the backup server 
everyday. This will go on until Day 100 because it is the [Maximum number of delta] (default) allowed in this 
backup set and the whole Outlook.pst file will be uploaded again. You can set the [Maximum number of delta] 
setting to [Unlimited] if you don’t want to upload the full file again. 

All delta files are generated with respect to changes made since the last incremental backup. This means that the 
last full backup file and ALL incremental delta backup files are required to restore the latest snapshot of a backup 
file.  

The full backup file, its checksum file and all incremental delta files stored on the server are always stored in the 
data area. This means that these files are not affected by the setting of the retention policy and will always be 
kept on the backup server. This is done this way because all these files are required to get the latest snapshot of 
the backup file and they should not be removed from the backup server by the retention area cleanup routine. 

Differential in-file delta type 

Example 1: If you are adding 200MB to 10GB Outlook.pst everyday, the first delta backup will upload a 200MB 
delta file and the next delta backup will upload another 200MB delta file. This will go on until Day 50 when the 
delta file required to be backed up reached 10GB. This delta file size (10GB) is now is 50% of the Outlook.pst that 
is 20GB (remember that you have added 100MB to this file everyday). If the [Delta Ratio] is set to be 50% 
(default), the whole Outlook.pst file will be uploaded again. 
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Example 2: If you are adding 50MB to a 10GB Outlook.pst everyday, the first delta backup will upload a 50MB 
delta file and the next delta backup will upload a 50MB delta file. This will go on until Day 100 because it is the 
[Maximum number of delta] (default) allowed in this backup set and the whole Outlook.pst file will be uploaded 
again. 

All delta files are generated with respect to changes made since the last full backup file (i.e. differential backup). 
This means that only last full backup file and the last delta file are required to restore the latest snapshot of a 
backup file. This means that other intermediate delta files are only required if you want to restore other snapshots 
of a backup file. 

Differential in-file delta backup has the benefits that a corrupted delta file would only make one particular version 
of a backup file non-recoverable and all other backups created by other delta files of the same file would still be 
intact. 

The full backup file, its checksum file and the last delta file uploaded (if more than one delta files have been 
uploaded to the backup server) is always stored in the data area. This means that these files are not affected by 
the setting of the retention policy and will always be kept on the backup server. This is done this way because all 
these files are required to get the latest snapshot of the backup file and they should not be removed from the 
backup server by the retention area cleanup routine. All other intermediate delta files are stored in the retention 
area. 

 

7.2 Block Size 
The block size defines the size of data block being used to detect changes between last full backup file and the file 
sitting on the local computer right now. In general, the smaller the block size, the more likely a matched data 
block can be found between the last full backup file and the file on local computer. It, therefore, produces in a 
smaller delta file but it would require more processing power to detect these changes. On the other hand, in-file 
delta backup running with larger block size will run faster but this will generally produce a larger delta file. 

 



committed to the success of your business 
Ahsay Offsite Backup Server v5.1

User’s Guide
 

 

Leb Shama Company Limited Page 55 of 120 (June 16, 2006)
 

In most case, the default setting [Auto] will choose the optimal block size for each file (depending on the size of 
the file) for you. 

7.3 Minimum File Size 
The [Minimum File Size] setting defines the smallest file size a file must have before the use and application of in-
file delta backup technology.  

If the size of a file that is being backed up is smaller than the [Minimum File Size] setting, in-file delta backup 
technology won’t be applied to this file and the whole file, instead of just the delta file, will be uploaded to the 
backup server. It is not necessary to perform in-file delta backup on small files because backing up the whole file 
doesn’t take too long anyway. Backing up the whole file instead reduces the time required to restore a backup file. 

7.4 Uploading full file again 

No. of Delta 

The [No. of delta] setting defines the maximum number of delta files from the same full backup file to be 
generated and backed up to the backup server before a full backup (the whole file) of this file is uploaded to the 
backup server instead.  

For example, if you have created 100 delta files from the full backup file already and the [No. of delta] setting is 
100, the next backup will upload a full backup file (the whole file) instead of just the delta file. However, if the [No. 
of delta] setting is unlimited, it will keep generating delta files and uploading these delta files to the backup server 
until any of the other delta setting conditions force a full backup (e.g. delta ratio is exceeded). This setting is here 
to make sure that there will always be a full backup file after a certain number of delta files have been generated. 

Delta Ratio 

The [Delta Ratio] setting is defined to be the size of a delta file divided by the size of its full backup file (i.e. the 
percentage of changes detected between the last full backup file and the current file).  

If delta ratio calculated from the size of the generated delta file and the size of the full backup is greater than the 
[Delta Ratio] setting, the whole file, instead of just the delta file, will be backed up to the backup server. It is done 
this way because the difference between backing up the whole file and the delta file is not significant and it is 
better to upload the whole file instead to reduce the time required to restore the file. 

The default setting of [Delta Ratio] is 50%. This means that if more than 50% changes have been detected, the 
whole file, instead of just the delta file, will be backed up and uploaded to the backup server.  

7.5 Advanced In-file delta type 
The [In-file delta] -> [Advanced] setting allows user to override default in-file delta type when on a certain 
number of days (e.g. all Sundays or the 1st day of each month). This is useful if you want all in-file delta backups 
to be incremental but you always want to do full backup on Sundays as well as the 1st day of every month. If you 
want to do this, simply configure [In-file delta] -> [Advanced] -> [Advanced In-file Delta Type Setting] to what is 
shown below.  

 



committed to the success of your business 
Ahsay Offsite Backup Server v5.1

User’s Guide
 

 

Leb Shama Company Limited Page 56 of 120 (June 16, 2006)
 

 

With this setting, all backup jobs starts on Sundays or the 1st day of each month will run a full backup job. In this 
case, all backup files which have been backed up incrementally/differentially using in-file delta feature will be 
uploaded in full again. This ensures that all backup files will be backed up in full at a regular interval. One benefit 
of this is that restore time will run faster because of less delta merging. Another benefit is that the risk of a 
corrupted incremental delta file resulting in data loss is much lower because a full backup is always available 
periodically. 
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8 Backup/Restore Oracle 8i/9i 
This chapter will describe in details how AhsayOBM backup your Oracle 8i/9i and how you can restore an Oracle 
8i/9i database using the backup files.  

8.1 Requirements 
i. AhsayOBM must be installed onto the computer that can connect to your Oracle 8i/9i server using 

TCP/IP protocol. 

ii. Data from Oracle 8i/9i database will be backed up to a temporary directory before they are sent to 
Ahsay Offsite Backup Server. Please make sure you have sufficient space on your computer to store 
these data when you run the backup job. 

iii. Database must be in archived log mode 
 
To switch to archived log mode and enable automatic log archiving, please do the following: 

a. Set the parameters below in the PFILE to enable automatic archiving 
 
log_archive_dest = [directory where archived logs will be stored] 
log_archive_format = ARCH%S.LOG 
log_archive_start = TRUE 

b. Switch to archived log mode 
 
SVRMGRL> connect internal; 
SVRMGRL> startup mount; 
SVRMGRL> alter database archivelog; 
SVRMGRL> alter database open; 

c. Enable Oracle JVM for Oracle 8i/9i, please do the following: 

1. Please make sure shared pool size is larger than 50MB and java pool size is larger than 
20MB in the PFILE. For example: 
 
java_pool_size = 20971520 
shared_pool_size = 52428800 

2. Run the scripts below  
 
For Oracle 8i 
SVRMGRL> connect internal 
SVRMGRL> @?/javavm/install/initjvm.sql; 
SVRMGRL> @?/rdbms/admin/catalog.sql; 
SVRMGRL> @?/rdbms/admin/catproc.sql; 
SVRMGRL> @?/javavm/install/initdbj.sql; 
 
For Oracle 9i 
SQL> connect sys/change_on_install as sysdba 
SQL> @?/javavm/install/initjvm.sql; 
SQL> @?/xdk/admin/initxml.sql; 
SQL> @?/xdk/admin/xmlja.sql; 
SQL> @?/rdbms/admin/catjava.sql; 
 
For Oracle 10g 
Oracle JVM is enabled by default. No additional steps required.  

iv. JAVASYSPRIV role is granted to system account 
 
You can grant this role to system account by executing: 
 
SQL> grant JAVASYSPRIV to system; 
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8.2 Overview 
AhsayOBM will backup your Oracle database by taking the following steps. 

i. Connect to the Oracle database using SQL*NET over TCP/IP 

ii. Run all Pre-Commands of this backup set 

iii. If the backup type to run is [Database Backup type], 

a. all data files in each of the tablespace(s) selected are copied to the temporary directory 
specified by this backup set 

b. if there are temporary files in the database, the script to re-create the temporary files are 
generated to a file located in the temporary directory specified by this backup set 

c. all non-default initialization parameters will be spooled to an initializing file located in the 
temporary directory specified by this backup set 

d. all control files will be copied to the temporary directory specified by this backup set 

e. all archived log files will be copied to the temporary directory specified by this backup set 

iv. If the backup type to run is [Archived Log Backup type], 

a. all archived log files will be copied to the temporary directory specified by this backup set  

v. Run all Post-Commands of this backup set 

vi. Upload all files copied to the temporary directory to the Ahsay Offsite Backup Server 

vii. Remove temporary files from the temporary directory if [Setting] -> [Temporary Directory for 
storing backup files] is enabled 

Note: 
If your Oracle database is running on Windows, please install AhsayOBM onto the company running the Oracle 
database if AhsayOBM is to backup this Oracle database. This would shorten the time required to backup the 
Oracle database. 
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8.3 How to backup an Oracle Database 
Please follow the instructions below to backup your Oracle database to the Ahsay Offsite Backup Server.  

i. Install AhsayOBM onto your computer 

ii. Open AhsayOBM 
 
Right click AhsayOBM icon available in the system tray and choose [Open]  
 

 
 

iii. Create a backup set  

a. From the Menu, Choose [Backup Set] -> [New] -> [Oracle Database Backup Set]  
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b. Enter a name for your backup set 
 

 

c. Enter the system password, the Oracle Database Server Host Name, TNS Port and SID 

d. Select the tablespace(s) you want to backup 
 

 

e. Enter a temporary location to store the database file(s) before they are sent to an Ahsay 
Offsite Backup Server 
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f. Set the backup schedule for database backup and archived log backup 
 

 
 

 

Note: You can have more than one schedule in a backup set, i.e. you can perform intra-day transaction log backup 
by adding more than one daily transaction log backup schedule to your backup set. 

g. Set the encryption algorithm, encryption mode and encrypting key for this backup set 
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Hint: For maximum security, please select AES (Advanced Encryption Standard) Algorithm, 
CBC (Cipher Block Chaining) mode and use an encrypting key with more than 8 characters. 

iv. Run Backup  

a. Select the backup set you want to run on the left panel and press the [Start Backup] button 
(►) 
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b. Select the backup type (e.g. Database Backup, Archived Log Backup) you would like to 
perform 
 

 
 

c. Select [Off-site Backup Server] to start backing up your files to an Ahsay Offsite Backup 
Server.  
 

 
 

8.4 How to restore an Oracle Database 
Please follow the instructions below to restore your Oracle 8i/9i databases from an Ahsay Offsite Backup Server.  

i. Download the backup files from the Ahsay Offsite Backup Server 
 
Please refer to the [Quick Start - Backup File] section for information on how to download backup 
files from Ahsay Offsite Backup Server. 

ii. Put all data files back to their original locations 

iii. Control files, data files and archived logs are stored on Ahsay Offsite Backup Server along with 
their full path information. You just need to put all these files back to their original locations when 
performing a database restore. 

iv. Put the PFILE back to its default location 
 
Oracle 8i: $ORACLE_HOME/dbs/init<SID>.ora 
Oracle 9i: $ORACLE_HOME/admin/<SID>/pfile/init.ora 

v. Restore Database 
 
(if Oracle 8i) Use Server Manager to restore you database by doing the following:  

a. Run Oracle Server Manager (svrmgrl) 

b. Connect to the target database 

c. Startup mount 

d. Reapply all transactions from the archived log files 

e. Open database 

Oracle 8i Example: 
$ svrmgrl 
 
SVRMGRL> connect internal 
 
SVRMGR> startup mount; 
ORACLE instance started. 
Total System Global Area  95874448 bytes 
Fixed Size   64912 bytes 
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Variable Size   52744192 bytes 
Database Buffers   40960000 bytes 
Redo Buffers   2105344 bytes 
Database mounted. 
 
SVRMGRL> recover database using backup controlfile 
ORA-00279: change 419671 generated at 06/14/03 02:51:49 needed for thread 1 
ORA-00289: suggestion : /data/ora815/vin/archive/ARCH0000000225.LOG 
ORA-00280: change 419671 for thread 1 is in sequence #225 
ORA-00278: log file '/data/ora815/vin/archive/ARCH0000000224.LOG' no longer needed for this 
recovery 
Specify log: {<RET>=suggested | filename | AUTO | CANCEL} 
AUTO 
Log applied. 
. . . . . . . . . . .  
ORA-00279: change 547222 generated at 06/18/03 19:58:26 needed for thread 1 
ORA-00289: suggestion : /data/ora815/vin/archive/ARCH0000000384.LOG 
ORA-00280: change 547222 for thread 1 is in sequence #384 
ORA-00278: log file '/data/ora815/vin/archive/ARCH0000000383.LOG' no longer needed for this 
recovery 
ORA-00308: cannot open archived log '/data/ora815/vin/archive/ARCH0000000384.LOG' 
ORA-27037: unable to obtain file status 
Linux Error: 2: No such file or directory 
Additional information: 3 
 
SVRMGR> recover database using backup controlfile until cancel 
ORA-00279: change 547222 generated at 06/18/03 19:58:26 needed for thread 1 
ORA-00289: suggestion : /data/ora815/vin/archive/ARCH0000000384.LOG 
ORA-00280: change 547222 for thread 1 is in sequence #384 
Specify
CANCEL 

 log: {<RET>=suggested | filename | AUTO | CANCEL} 

Media recovery cancelled. 
SVRMGR> alter database open resetlogs; 
Statement processed. 

 

(if Oracle 9i) Use Recovery Manager to restore you database by doing the following:  

a. Run Oracle Server Manager (rman) 

b. Connect to the target database 

c. Startup mount 

d. Reapply all transactions from the archived log files to the last sequence 

e. Open database 

Oracle 9i Example: 
C:\>rman nocatalog 
 
Recovery Manager: Release 9.2.0.1.0 - Production 
 
Copyright (c) 1995, 2002, Oracle Corporation.  All rights reserved. 
 
RMAN> connect target 
 
connected to target database (not started) 
 
RMAN> startup mount 
 
connected to target database (not started) 
Oracle instance started 
database mounted 
 
Total System Global Area     269556596 bytes 
 
Fixed Size                      453492 bytes 
Variable Size                243269632 bytes 
Database Buffers              25165824 bytes 
Redo Buffers                    667648 bytes 
 
RMAN> recover database until sequence=63 thread=1; 
 
Starting recover at 24-JUN-03 
allocated channel: ORA_DISK_1 
channel ORA_DISK_1: sid=11 devtype=DISK 
 
starting media recovery 
 
archive log thread 1 sequence 56 is already on disk as file 
C:\ORACLE\ORADATA\VIN\ARCHIVE\1_56.DBF 
archive log filename=C:\ORACLE\ORADATA\VIN\ARCHIVE\1_56.DBF thread=1 sequence=56 
archive log filename=C:\ORACLE\ORADATA\VIN\ARCHIVE\1_57.DBF thread=1 sequence=57 
archive log filename=C:\ORACLE\ORADATA\VIN\ARCHIVE\1_58.DBF thread=1 sequence=58 
archive log filename=C:\ORACLE\ORADATA\VIN\ARCHIVE\1_59.DBF thread=1 sequence=59 
archive log filename=C:\ORACLE\ORADATA\VIN\ARCHIVE\1_60.DBF thread=1 sequence=60 
archive log filename=C:\ORACLE\ORADATA\VIN\ARCHIVE\1_61.DBF thread=1 sequence=61 
archive log filename=C:\ORACLE\ORADATA\VIN\ARCHIVE\1_62.DBF thread=1 sequence=62 
media recovery complete 
Finished recover at 24-JUN-03 
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RMAN> alter database open resetlogs; 
 
database opened 
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9 Backup/Restore Microsoft SQL Server 7.0 / 2000 
This chapter will describe in details how to use AhsayOBM to backup your Microsoft SQL Server 7.0 / 2000 server 
and how you can restore your Microsoft SQL Server 7.0 / 2000 server from the backup files.  

9.1 Requirements 
i. AhsayOBM must be installed onto the computer running Microsoft SQL Server. 

ii. Data from Microsoft SQL Server will be backed up to a temporary directory before they are sent to 
Ahsay Offsite Backup Server. Please make sure you have sufficient space on your computer to 
store these data when you run the backup job.  

9.2 Overview 
AhsayOBM will backup your Microsoft SQL Server database(s) by taking the following steps: 

i. Before running any backup activities, AhsayOBM will run all Pre-Commands of the backup set. 

ii. For each database that is to be backed up, AhsayOBM will issue a database / transaction log 
backup command to Microsoft SQL Server to backup each database to a Microsoft SQL Server 
database backup file (*.bak file) and save it in the temporary directory you specified. 

iii. After all *.bak files have been spooled to the temporary directories, AhsayOBM will run all Post-
Commands of the backup set. 

iv. Upload all files copied to the temporary directory to the Ahsay Offsite Backup Server. 

v. Remove temporary files from the temporary directory if [Setting] -> [Temporary Directory for 
storing backup files] is enabled 
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9.3 How to backup Microsoft SQL Server database(s) 
Please follow the instructions below to backup your Microsoft SQL Server databases using AhsayOBM.  

vi. Open AhsayOBM 
 
Right click AhsayOBM icon available in the system tray and choose [Open]  
 

 
 

vii. Create a backup set  

a. From the Menu, Choose [Backup Set] -> [New] -> [MS SQL Server Backup Set] 
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b. Enter a name for your backup set 
 

 

c. Enter the Microsoft SQL Server administrator username and password 

d. Select the database(s) you want to backup 
 

 

e. Enter a temporary location to store the backup files before they are sent to an Ahsay Offsite 
Backup Server 
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f. Set the backup schedule for full database backup and transaction log backup 
 

 
 
(Note: You can have more than one schedule in a backup set, i.e. you can perform intra-day 
transaction log backup by adding more than one daily transaction log backup schedule to 
your backup set) 

g. Set the encryption algorithm, encryption mode and encrypting key for this backup set 
 

 
 
(Hint: For maximum security, please select AES (Advanced Encryption Standard) Algorithm, 
CBC (Cipher Block Chaining) mode and use an encrypting key with more than 8 characters.) 

viii. Run Backup  

a. Select the backup set you want to run on the left panel and press the [Start Backup] button 
(►) 
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b. Select the backup type (e.g. Complete, Differential, Transaction Log) you would like to 
perform 
 

 

c. Select [Off-site Backup Server] to start backing up your files to an Ahsay Offsite Backup 
Server. 
 

 

9.4 How to restore Microsoft SQL Server database(s) 
Please follow the instructions below to restore your Microsoft SQL Server databases from an Ahsay Offsite Backup 
Server.  

i. Download the backup files (.bak) from the Ahsay Offsite Backup Server 
 
Please refer to the [Quick Start - Backup File] section for information on how to download backup 
files from Ahsay Offsite Backup Server. 

ii. Open Microsoft SQL Enterprise Manager  
 
You can open Microsoft SQL Enterprise Manager from [Start Menu] -> [Program] -> [Microsoft 
SQL Server] -> [Enterprise Manager] 

iii. (Optional) Restore “master” database  

You need to restore “master” database if you: 
a. are rebuilding all your databases from scratch 

b. have changing any server-wide or database configuration options 
c. have added logins or other login security-related operations.  
d. have created or removed logical backup devices. 
e. have configured the server for distributed queries and remote procedure calls, such as adding 

linked servers or remote logins. 
 
You do not need to restore your master database if you just want to restore a user database. For 
more information on Microsoft SQL Server “master” database, please visit 
http://www.microsoft.com/sql/.  
 

 

http://www.microsoft.com/sql/
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To restore “master” database, please do the following: 
 

a. Start Microsoft SQL Server in “Single User Mode” 

1. Right click your Microsoft SQL Server and select [Properties] 
 

 
 

2. Press the [Startup Parameters] button 
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3. Add a “-m” parameter to the [Startup Parameters] 
 

 
 

4. Restart Microsoft SQL Server 
 
From [Enterprise Manager], right click your Microsoft SQL Server and select [Stop] and 
then [Start]. 
 

 
 

 
 

b. Restore “master” database 
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1. From [Enterprise Manager] -> [Tools] -> [Restore Database] 
 

 
 

2. Select [master] in the [Restore as database] drop down list  

3. Select the [From device] radio button. 
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4. Press the [Select Devices] button. 
 

 
 

5. From the [Choose Restore Devices], press the [Add] button. 
  

 

6. From the [Choose Restore Destination] panel, press the […] button to choose your master 
backup (*.bak) from your backup files 
 

 
 

7. Press the [OK] button, to start restoring the “master” database. 
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c. Restart Microsoft SQL Server in “Normal Mode” 

1. Remove “-m” parameter from the [Startup Parameters] as in previous step 

2. Restart your Microsoft SQL Server as in previous step 

iv. (Optional) Restore “model”, “msdb” and “distribution” database 
 
You need to restore “model” database if you have changed the database template of your SQL 
Server.  
 
You need to restore “msdb” database if you have changed the scheduling information or you want 
to restore the backup and restore history of your databases. 
 
You need to restore “distribution” database if you are running the replication components of SQL 
Server. 
 
You do not need to restore these databases if you just want to restore a user database. For more 
information on Microsoft SQL Server “model”, “msdb” and “distribution” database, please visit 
http://www.microsoft.com/sql/.  
 
You need to restore each of these databases one by one. To restore any of these databases, 
please do the following: 

a. From [Enterprise Manager] -> [Tools] -> [Restore Database] 

b. Select the database to be restored in the [Restore as database] drop down list  

c. Select the [From device] radio button. 

d. Press the [Select Devices] button 

e. Press the […] button to choose your backup files (*.bak) for the database to be restored 

f. Press the [OK] button 

v. Restore user database(s)  
 
For each of the database you would like to restore,  

a. From [Enterprise Manager] -> [Tools] -> [Restore Database] 

b. Select the database to be restored in the [Restore as database] drop down list  

 

http://www.microsoft.com/sql/
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c. Select the [Database] radio button. 
 

 
 

d. From the [Show backups of database] drop down list, select the database to be restored 

e. From the [First backup to restore] drop down list, select the snapshot of the database you 
would like to restore to.  
 
You can restore your database to the snapshot of your database at any point of the time 
between the time you did your full backup and the time you did your last subsequent backup.  

f. Change the [Restore From] entry  
 
If you backup files (*.bak) are not in the default directory, you need to update the full path 
to your backup files by pressing the [Properties] button. 

g. Press the [OK] button 

vi. All database(s) restored successfully 
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10 Backup/Restore Lotus Domino / Notes 
This chapter will describe in details how to use AhsayOBM to backup your Lotus Domino server / Notes client 5 / 6 
/ 6.5 and how you can restore your Lotus Domino server / Notes client 5 / 6 / 6.5 from the backup files.  

10.1 Requirements 
i. AhsayOBM must be installed onto the computer running Lotus Domino server / Notes client. 

ii. Data from Lotus Domino server / Notes client will be backed up to a temporary directory before 
they are sent to Ahsay Offsite Backup Server. Please make sure you have sufficient space on your 
computer to store these data when you run the backup job. 

iii. Lotus Domino server must runs with archive transaction logging enabled 
 
To set up transaction logging in archive style, please do the following: 

a. Ensure that all databases to be logged reside in the Domino data directory, either at the root 
or in subdirectories. 

b. From the Domino Administrator, click the Configuration tab. 

a. In the "Use Directory on" field, choose the server's Domino Directory. 

b. Click Server Configuration, and then click Current Server Document. 

c. Click the Transactional Logging tab. 

d. Complete these fields, and then save the document. 

Field Enter 

Transactional Logging Choose Enabled. The default is Disabled. 

Log path Path name location of the transaction log. 
The default path name is \LOGDIR in the Domino 
data directory, although it is strongly recommended 
to store the log on a separate, mirrored device, such 
as a RAID (Redundant Array of Independent Disks) 
level 0 or 1 device with a dedicated controller. 
The separate device should have at least 1GB of disk 
space for the transaction log. If you are using the 
device solely for storing the transaction log, set the 
"Use all available space on log device" field to Yes. 

Maximum log space The maximum size, in MB, for the transaction log. 
Default is 192MB. Maximum is 4096MB (4GB). 
Domino formats at least 3 and up to 64 log files, 
depending on the maximum log space you allocate. 

Use all available space 
on log device 

Choose one: 
y Yes to use all available space on the device for 

the transaction log. This is recommended if you 
use a separate device dedicated to storing the 
log. If you choose Yes, you don’t need to enter a 
value in the "Maximum log space" field. 

y No to use the default or specified value in the 
"Maximum log space" field. 

Automatic fixup of 
corrupt databases 

Choose one: 
y Enabled (default). If a database is corrupt and 

Domino cannot use the transaction log to 
recover it, Domino runs the Fixup task, assigns 
a new DBIID, and notifies the administrator that 
a new database backup is required. 

y Disabled. Domino does not run the Fixup task 
automatically and notifies the administrator to 
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run the Fixup task with the -J parameter on 
corrupt logged databases. 

Runtime / Restart 
performance 

This field controls how often Domino records a 
recovery checkpoint in the transaction log, which 
affects server performance. 
To record a recovery checkpoint, Domino evaluates 
each active logged database to determine how many 
transactions would be necessary to recover each 
database after a system failure. When Domino 
completes this evaluation, it: 
y Creates a recovery checkpoint record in the 

transaction log, listing each open database and 
the starting point transaction needed for 
recovery 

y Forces database changes to be saved to disk if 
they have not been saved already 

Choose one: 
y Standard (default and recommended). 

Checkpoints occur regularly. 
y Favor runtime. Domino records fewer 

checkpoints, which requires fewer system 
resources and improves server run time 
performance. 

y Favor restart recovery time. Domino records 
more checkpoints, which improves restart 
recovery time because fewer transactions are 
required for recovery. 

Logging style Choose Archive. The default is Circular. 
 
Notes: 
You can only run transaction log backup if you have transaction logging enabled and you are 
using archive mode. This command does not apply if you have transaction logging enabled not 
in archive mode or if transaction logging is not enabled at all. If you try to issue it, you will 
receive an error message. 

 

10.2 Overview 
AhsayOBM will backup your Lotus Domino server / Notes client by taking the following steps: 

i. Run all Pre-Commands of this backup set 

ii. If the backup type to run is [Database Backup type], 

a. all file(s) / database(s) selected are copied to the temporary directory specified by this 
backup set 

b. the notes.ini file, if selected, will be copied to the temporary directory 

c. only filled log extents will be copied to the temporary directory, and the Domino server is 
notified of their availability for reuse (for Domino server only) 

iii. (for Domino server only) If the backup type to run is [Transaction Log Backup type], 

a. only filled log extents will be copied to the temporary directory, and the Domino server is 
notified of their availability for reuse 

iv. Run all Post-Commands of this backup set 

v. Upload all files copied to the temporary directory to the Ahsay Offsite Backup Server  

vi. Remove temporary files from the temporary directory if [Setting] -> [Temporary Directory for 
storing backup files] is enabled 
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10.3 How to backup Lotus Domino / Notes database(s) / file(s) 
Please follow the instructions below to backup your Lotus Domino server / Notes client databases / files using 
AhsayOBM. 

i. Open AhsayOBM 
 
Right click AhsayOBM icon available in the system tray and choose [Open]  
 

 
 

ii. Create a backup set 

a. From the Menu, Choose [Backup Set] -> [New] -> [Lotus Backup Set] 
 

 
 

b. Enter a name for your backup set 
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c. Select the Backup Set Type (Lotus Domino Server Backup / Lotus Notes Client Backup) 
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d. Select the database(s) / file(s) you want to backup 
 

 

e. Enter a temporary location to store the backup files before they are sent to an Ahsay Offsite 
Backup Server 

f. Set the backup schedule for Database Backup 
 

 

g. Set the backup schedule for Transaction Log Backup (for Domino server only) 
(Note: You can have more than one schedule in a backup set, i.e. you can perform intra-day 
transaction log backup by adding more than one daily transaction log backup schedule to 
your backup set) 
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h. Set the encryption algorithm, encryption mode and encrypting key for this backup set 
 

 
 
(Hint: For maximum security, please select AES (Advanced Encryption Standard) Algorithm, 
CBC (Cipher Block Chaining) mode and use an encrypting key with more than 8 characters.) 

iii. Run Backup  

a. Select the backup set you want to run on the left panel and press the [Start Backup] button 
(►) 

b. Select the backup type (e.g. Database, Transaction Log) you would like to perform (for 
Domino server only) 
 

 

c. Select [Off-site Backup Server] to start backing up your files to an Ahsay Offsite Backup 
Server. 
 

 

10.4 How to restore Lotus Domino / Notes database(s) / file(s) 
Please follow the instructions below to restore Lotus Domino server / Notes client database(s) / file(s) from an 
Ahsay Offsite Backup Server.  

i. Install Lotus Domino server / Notes client back to its original folder (if required) 

ii. Install AhsayOBM 
 
Please refer to the [Installation] section for information on how to install AhsayOBM onto your 
computer. 

iii. Copy LotusMediaRecovery.exe from the bin directory (default to C:\Program Files\AhsayOBM\bin) 
to Lotus Domino installation directory (default to C:\Lotus\Domino) 

iv. Shutdown Lotus Domino Server 
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v. If you want to perform a full domino restore (restore all databases and files): 

a. Download the backup files to be restored from the Ahsay Offsite Backup Server and save 
them back to its original location. It includes notes.ini, all backup files from the lotus domino 
data directory and all archived transaction logs 

b. Run LotusMediaRecovery.exe from the Lotus Domino installation directory (e.g. 
C:\Lotus\Domino\LotusMediaRecovery.exe) and press ‘Y’ to continue.  
 
For example: C:\Lotus\Domino\> LotusMediaRecovery.exe  
 
This will run media recovery for all databases (*.nsf and mail.box) found under the Lotus 
data directory (e.g. C:\Lotus\Domino\Data). You should see something similar to the screen 
below. 

Media Recovery Example: 
 
C:\Lotus\Domino>LotusMediaRecovery 
Media Recovery Utility for Lotus Domino 5.0 or above 
 
Please make sure that you have done the following: 
1. Reinstall Lotus Domino on this computer in the same directory 
2. Restore Notes.ini to the Lotus Domino installation directory 
   (e.g. C:\Lotus\Domino) 
3. Restore Domino Data directory back to the directory defined 
   in Notes.ini (e.g. C:\Lotus\Domino\Data) 
4. Restore all archived transaction logs to the directory defined 
   in Notes.ini (e.g. C:\Lotus\Domino\Data\logdir) 
 
Continue ? (Y) or (N) y 
Running media recovery ... 
Please wait, creating new transaction logs in directory: C:\logdir\ 
02/12/2003 14:39:19   Recovery Manager: Restart Recovery complete. (0/0 
databases needed full/partial recovery) 
Media Recovery Replay (122 MB): 10% 20% 30% 40% 50% 60% 70% 80% 90% 100% 
02/12/2003 14:39:22   Recovery Manager: Media Recovery complete for 
C:\Lotus\Domino\Data\admin4.nsf, last update applied . 
 
 Backup file C:\Lotus\Domino\Data\admin4.nsf recovered. 
 
………… 
 
Media Recovery Replay (122 MB): 10% 20% 30% 40% 50% 60% 70% 80% 90% 100% 
02/12/2003 14:40:57   Recovery Manager: Media Recovery complete for 
C:\Lotus\Domino\Data\statrep.nsf, last update applied . 
 
 Backup file C:\Lotus\Domino\Data\statrep.nsf recovered. 
 
C:\Lotus\Domino> 

 

c. All content of all database(s) are now rolled forward to the last committed transaction found 
in the last archived transaction log. 

d. Restart Lotus Domino server 

vi. If you just want to restore a single database: 

a. Download the database file to be restored from the Ahsay Offsite Backup Server and save 
them back to its original location.  

b. (optional) If you need to perform media recovery on this database, please download all 
archived transaction logs and save them back to its original location 

c. Run LotusMediaRecovery.exe from the Lotus Domino installation directory with an argument 
of the full path of database to be restored. 
 
For example, if you want to restore C:\Lotus\Domino\data\admin4.nsf, please run: 
 
C:\Lotus\Domino\> LotusMediaRecovery.exe C:\Lotus\Domino\data\admin4.nsf  
 
You should see something similar to the screen below. 

Media Recovery Example: 
 
C:\Lotus\Domino>LotusMediaRecovery C:\Lotus\Domino\data\admin4.nsf 
Media Recovery Utility for Lotus Domino 5.0 or above 
 
Running media recovery ... 
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Restart Analysis (0 MB): 100% 
02/12/2003 14:42:15   Recovery Manager: Restart Recovery complete. (0/0 
databases needed full/partial recovery) 
Media Recovery Replay (122 MB): 10% 20% 30% 40% 50% 60% 70% 80% 90% 100% 
02/12/2003 14:42:17   Recovery Manager: Media Recovery complete for 
C:\Lotus\Domino\data\admin4.nsf, last update applied 01/12/2003 00:02:42. 
 
 Backup file C:\Lotus\Domino\data\admin4.nsf recovered. 
 
 
C:\Lotus\Domino> 

 
 

d. All content of the database are now rolled forward to the last committed transaction found in 
the last archived transaction log. 

vii. Restart Lotus Domino Server 
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11 Backup/Restore Microsoft Exchange Server 
This chapter will describe in details how to use AhsayOBM to backup your Microsoft Exchange Server 2000 / 2003 
and how you can restore your Microsoft Exchange Server 2000 / 2003 from the backup files. 

11.1 Requirements 
i. Microsoft Exchange Server 2000 with Services Pack 3 and post-SP3 update rollup installed. Please 

refer to http://www.microsoft.com/exchange/ for more information. 
 or 
Microsoft Exchange Server 2003. 

ii. AhsayOBM must be installed onto the computer running Microsoft Exchange Server 2000 / 2003. 

iii. Data from Microsoft Exchange Server will be backed up to a temporary directory before they are 
sent to Ahsay Offsite Backup Server. Please make sure you have sufficient space on your 
computer to store these data when you run the backup job. 

11.2 Overview 
A Microsoft Exchange Server 2000/2003 stores its data in Windows Active Directory as well as in its databases. To 
fully backup a Microsoft Exchange Server 2000/2003, you need to backup the following components: 

i. Windows System State 
 
The Windows System State contains the information about your Windows system, including 
Windows Active Directory. A Microsoft Exchange Server 2000 / 2003 stores some of its 
configuration, e.g. email accounts and mailbox properties, inside Windows Active Directory. It is 
important that Windows Active Directory is backup properly when backing up a Microsoft Exchange 
Server. 
 
Active Directory is stored inside a Windows Server running as Windows domain controller. If your 
Exchange Server is a domain controller, you can simply backup the Windows System State of your 
Exchange Server. If your Exchange Server is running as a member server, you will need to install 
another copy of AhsayOBM onto the domain controller to backup the Windows System State of 
inside the domain controller. 
 
For more information on Active Directory, please refer to 
http://www.microsoft.com/windows2000/technologies/directory/ad/default.asp 

ii. Microsoft Information Store 
Exchange Server stores all emails and documents inside its databases, which are grouped together 
as storage groups inside Microsoft Information Store. It is important that Microsoft Information 
Store is fully backup when backing your Exchange Server.  

iii. Microsoft Site Replication Service 
Microsoft Site Replication Service is installed automatically when exchange server site replication 
feature is enabled. Microsoft Site Replication stores its runtime and configuration information 
inside its own database. If you are running your Exchange Server with Site Replication Service 
enabled, please make sure that you backup the site replication database as well.  

iv. Microsoft Key Management Service (Exchange 2000 only) 
Similarly, if you have setup your Exchange Server with Key Management Services enabled, please 
make sure that you backup the key management database as well. 

AhsayOBM will backup your Microsoft Exchange Server by taking the following steps: 

v. Run all Pre-Commands of this backup set 

vi. If the backup type to run is [Database Backup type], 

a. Windows System State will be backed up to a temporary directory specified in its backup set 

 

http://www.microsoft.com/exchange/
http://www.microsoft.com/windows2000/technologies/directory/ad/default.asp
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b. All exchange database(s) selected are backed up to a temporary directory specified in its 
backup set 

vii. If the backup type to run is [Transaction Log Backup type], 

a. New transaction log extents generated since last backup will be copied to the temporary 
directory 

viii. Remove transaction log extents backed up from the Exchange Server 

ix. Run all Post-Commands of this backup set 

x. Upload all backup files from the temporary directory to an Ahsay Offsite Backup Server 

xi. Remove temporary files from the temporary directory if [Setting] -> [Temporary Directory for 
storing backup files] is enabled 
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11.3 How to backup Microsoft Exchange Server 
Please follow the instructions below to backup your Microsoft Exchange Server 2000 / 2003 using AhsayOBM: 

i. Open AhsayOBM 
 
Right click AhsayOBM icon available in the system tray and choose [Open]  
 

 

ii. From the Menu, Choose [Backup Set] -> [New] -> [MS Exchange Backup Set] 
Create a backup set 

b. From the Menu, Choose [Backup Set] -> [New] -> [MS Exchange Backup Set] 
 

 
 

c. Enter a name for your backup set 
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d. Select the database(s) to be backup 
 

 
 
If this Exchange Server is also a domain controller of this Active Directory, select the [System 
State] checkbox as well. Otherwise, please install AhsayOBM to the domain controller of this 
Active Directory and select the [System State] checkbox on that computer 

e. Enter a temporary directory for storing the backup files before they are sent to an Ahsay 
Offsite Backup Server 

f. Set the backup schedule for Database Backup 
 

 

g. Set the backup schedule for Transaction Log Backup (for Domino server only) 
(Note: You can have more than one schedule in a backup set, i.e. you can perform intra-day 
transaction log backup by adding more than one daily transaction log backup schedule to 
your backup set) 

h. Set the encryption algorithm, encryption mode and encrypting key for this backup set 
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(Hint: For maximum security, please select AES (Advanced Encryption Standard) Algorithm, 
CBC (Cipher Block Chaining) mode and use an encrypting key with more than 8 characters.) 

iii. Run Backup  

i. Select the backup set you want to run on the left panel and press the [Start Backup] button 
(►) 
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j. Select the backup type (e.g. Database, Log Files) you would like to perform 
 

 

k. Select [Off-site Backup Server] to start backing up your files to an Ahsay Offsite Backup 
Server and press the [OK] button 
 

 

l. You should get something similar to the screen shot below. 
 

 

11.4 How to restore Microsoft Exchange Server 
Please follow the instructions below to restore Microsoft Exchange Server 2000 / 2003 from an Ahsay Offsite 
Backup Server.  

i. Prepare the system for your Exchange Server (if required) 
 
Install the original version of Windows and Exchange Server (with the same level of service pack 
installed as in the original system) back to your computer 

ii. Restore Windows Active Directory (if required) 
 
If you have re-installed Windows, please download the Windows System State backup file, named 
[SystemState.bkf], from Ahsay Offsite Backup Server and then use [NTBackup.exe] to restore 
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your Windows System State to its backup time from the backup file by following the instructions 
below: 

m. Run [NTBackup.exe] from [Start] -> [Run] 

n. Press the [Restore Wizard] button and then press the [Next] button 

o. Press the [Import] button and use the [Browse] button to select the backup file 
[SystemState.bkf] downloaded 

p. Select the checkbox next to the description that matches your backup file 

q. Press the [Next] button and then the [Finish] button 

iii. Install AhsayOBM (if required) 
 
Please refer to the [Installation] section for information on how to install AhsayOBM onto your 
computer. 

iv. Startup the [Microsoft Information Store] services from Windows Services 

v. Restore exchange database(s) from backup: 

a. Download the database backup files to be restored from the Ahsay Offsite Backup Server (or 
find the cached copy available in the temporary directory defined in your backup set) and 
save them to your hard disk (please make sure the directory structure is the same as it 
appears on the browser) 

b. If the database to be restored exists on your computer already, please dismount it from the 
services using [Start] -> [Program] -> [Microsoft Exchange] -> [System Manager] 

c. Use [ExchangeRestore.exe] from the [bin] directory under the installation directory of 
AhsayOBM (e.g. C:\Program Files\AhsayOBM\bin\ExchangeRestore.exe) to restore the 
exchange database(s). 
 
Simply run [ExchangeRestore.exe] to print the usage 

ExchangeRestore.exe Usage: 
C:\Program Files\AhsayOBM\bin> ExchangeRestore.exe 
 
Microsoft Exchange Server 2000/2003 Backup Recovery Utility 
 
Usage: 
ExchangeRestore DIR=path SERVER=server TEMP=tempDir [SERVICE=service [STORAGE=st 
orage [DATABASE=database]]] 
 
  DIR        Directory containing all backup files 
  SERVER   Name of Exchange Server to be restored 
  TEMP       Temporary directory to be used during restore 
             Please specific a path with plenty of free space 
  SERVICE   Name of Exchange Service to be restored. It must be either 
             "Microsoft Information Store", "Microsoft Key Management Service" 
             or "Microsoft Site Replication Service" 
  STORAGE   Name of storage group to be restored 
  DATABASE  Name of database to be restored 
 
Examples: 
1. To restore an exchange server: 
   ExchangeRestore DIR="C:\Backup" SERVER="ExchangeServer" TEMP="C:\Temp" 
 
2. To restore the information store: 
   ExchangeRestore DIR="C:\Backup" SERVER="ExchangeServer" TEMP="C:\Temp" 
      SERVICE="Microsoft Information Store" 
 
3. To restore an exchange storage group: 
   ExchangeRestore DIR="C:\Backup" SERVER="ExchangeServer" TEMP="C:\Temp" 
      SERVICE="Microsoft Information Store" STORAGE="StorageGroup1" 
 
4. To restore an exchange database: 
   ExchangeRestore DIR="C:\Backup" SERVER="ExchangeServer" TEMP="C:\Temp" 
      SERVICE="Microsoft Information Store" STORAGE="StorageGroup1" 
      DATABASE="Database1" 
where 
  "C:\Backup"    is the directory containing all backup files 
  "ExchangeServer"   is the server name of an exchange server 
  "C:\Temp"           is the temporary directory to be used 
  "StorageGroup1"    is the name of a storage group 
  "Database1"         is the name of a database 
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d. (Example 1) To restore all databases from backup available in [F:\Backup] to an exchange 
server named [WIN2000SVR] using the temporary directory [F:\Temp], you can use this 
command: 
 
E:\Program Files\AhsayOBM\bin> ExchangeRestore DIR="F:\Backup" TEMP="F:\Temp" 
SERVER="WIN2000SVR" 

Exchange Server Recovery Example: 
 
E:\Program Files\AhsayOBM\bin> ExchangeRestore DIR="F:\Backup" TEMP="F:\Temp" 
SERVER="WIN2000SVR" 
 
Microsoft Exchange Server 2000/2003 Backup Recovery Utility 
 
 [Start] Exchange Server - 'WIN2000SVR' 
  [Start] Service - 'Microsoft Information Store' 
   [Start] Storage Group - 'First Storage Group' 
    [Start] Database - 'Mailbox Store (WIN2000SVR)' 
     Restoring file 'E:\Program Files\Exchsrvr\mdbdata\priv1.edb' ... 
     Restoring file 'E:\Program Files\Exchsrvr\mdbdata\priv1.stm' ... 
    [End] Database - 'Mailbox Store (WIN2000SVR)' 
    [Start] Database - 'Public Folder Store (WIN2000SVR)' 
     Restoring file 'E:\Program Files\Exchsrvr\mdbdata\pub1.edb' ... 
     Restoring file 'E:\Program Files\Exchsrvr\mdbdata\pub1.stm' ... 
    [End] Database - 'Public Folder Store (WIN2000SVR)' 
    [Start] Restoring transaction log - 'First Storage Group' 
     Restoring Log File 'F:\Temp\restore.tmp\First Storage Group\E00000B3.log' ... 
     Restoring Log File 'F:\Temp\restore.tmp\First Storage Group\E00000B4.log' ... 
    [End] Restoring transaction log - 'First Storage Group' 
    [Start] Applying transaction log ... 
    [End] Applying transaction log 
   [End] Storage Group - 'First Storage Group' 
…………… 
   [Start] Storage Group - 'SG2' 
    [Start] Database - 'acct' 
     Restoring file 'E:\Program Files\Exchsrvr\SG2\acct.edb' ... 
     Restoring file 'E:\Program Files\Exchsrvr\SG2\acct.stm' ... 
    [End] Database - 'acct' 
    [Start] Restoring transaction log - 'SG2' 
     Restoring Log File 'F:\Temp\restore.tmp\SG2\E0100072.log' ... 
     Restoring Log File 'F:\Temp\restore.tmp\SG2\E0100073.log' ... 
    [End] Restoring transaction log - 'SG2' 
    [Start] Applying transaction log ... 
    [End] Applying transaction log 
   [End] Storage Group - 'SG2' 
[End] Exchange Server - 'WIN2000SVR' 
 
E:\Program Files\AhsayOBM\bin> 

 

e. (Example 2) To restore the database named [mail] in storage group [SG5] from backup 
available in [F:\Backup] to an exchange server named [WIN2000SVR] using the temporary 
directory [F:\Temp], you can use this command: 
 
E:\Program Files\AhsayOBM\bin> ExchangeRestore DIR="F:\Backup" TEMP="F:\Temp" 
SERVER="WIN2000SVR" SERVICE="Microsoft Information Store" STORAGE="SG5" 
DATABASE="mail1"  

Exchange Server Recovery Example: 
 
E:\Program Files\AhsayOBM\bin> ExchangeRestore DIR="F:\Backup" TEMP="F:\Temp" 
SERVER="WIN2000SVR" SERVICE="Microsoft Information Store" STORAGE="SG5" 
DATABASE="mail" 
 
Microsoft Exchange Server 2000/2003 Backup Recovery Utility 
 
 [Start] Storage Group - 'SG5' 

    [Start] Database - 'mail' 
     Restoring file 'E:\Program Files\Exchsrvr\SG5\mail.edb' ... 
     Restoring file 'E:\Program Files\Exchsrvr\SG5\mail.stm' ... 
    [End] Database - 'mail' 
    [Start] Restoring transaction log - 'SG5' 
     Restoring Log File 'F:\Temp\restore.tmp\SG5\E0300012.log' ... 
     Restoring Log File 'F:\Temp\restore.tmp\SG5\E0300013.log' ... 
    [End] Restoring transaction log - 'SG5' 
    [Start] Applying transaction log ... 
    [End] Applying transaction log 
   [End] Storage Group - 'SG5' 
 
E:\Program Files\AhsayOBM\bin> 

  

 

f. Repeat the same procedure for each database to be restored to the Exchange Server.  

g. You can use [Start] -> [Program] -> [Administrative Tools] -> [Event Viewer] to check if 
there are any errors generated from the exchange databases restoring activities. 
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vi. Completed 
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12 Backup/Restore Windows System State 
This chapter will describe in details how to use AhsayOBM to backup Windows System State and how you can 
restore your Windows System State from backup. 

12.1 Requirements 
i. Microsoft Windows NT / 2000 / XP / 2003 

ii. AhsayOBM must be installed onto the computer containing the system state you want to backup 

iii. Windows system state will be backed up to a temporary file before it is sent to AhsayOBS. Please 
make sure you have sufficient space on your computer to store the temporary file when you run 
the backup job. 

12.2 Overview 
AhsayOBM will backup your Microsoft Exchange Server by taking the following steps: 

i. Run all Pre-Commands of this backup set 

ii. Windows System State will be backed up to a temporary directory specified in its backup set 

iii. Run all Post-Commands of this backup set 

iv. Upload the Windows System State backup files from the temporary directory to an Ahsay Offsite 
Backup Server 

v. Remove the Windows System State temporary backup files from the temporary directory if 
[Setting] -> [Temporary Directory for storing backup files] is enabled 

12.3 How to backup Windows System State 
Please follow the instructions below to backup Windows System State using AhsayOBM: 

i. Open AhsayOBM 
 
Right click AhsayOBM icon available in the system tray and choose [Open]  
 

 

ii. Create a backup set  
 
From the Menu, Choose [Backup Set] -> [New] -> [System State Backup Set] 

a. From the Menu, Choose [Backup Set] -> [New] -> [System State Backup Set] 
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b. Enter a name for your backup set 
 

 

c. Use the [Change] button to configure the [Temporary directory for storing backup files] 
setting and check the [Remove temporary files after backup] if you want temporary files to 
be removed automatically after backup 
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d. Enter a temporary directory for storing the backup files before they are sent to an Ahsay 
Offsite Backup Server 

e. Set the backup schedule for this backup set 
 

 

f. Set the encryption algorithm, encryption mode and encrypting key for this backup set 
 

 
 
(Hint: For maximum security, please select AES (Advanced Encryption Standard) Algorithm, 
CBC (Cipher Block Chaining) mode and use an encrypting key with more than 8 characters.) 

iii. Run Backup  
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a. Select the backup set you want to run on the left panel and press the [Start Backup] button 
(►) 
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b. Select [Off-site Backup Server] to start backing up your files to an Ahsay Offsite Backup 
Server and press the [OK] button 
 

 

c. You should get something similar to the screen shot below. 
 

 

12.4 How to restore Windows System State 
Please follow the instructions below to restore Windows System State from an Ahsay Offsite Backup Server.  

i. Install AhsayOBM (if required) 
 
Please refer to the [Installation] section for information on how to install AhsayOBM onto your 
computer. 

ii. Restore the Windows System State Backup File (i.e. SystemState.bkf) from the backup server 

iii. Use [NTBackup.exe] to restore your Windows System State to its backup time from the backup file 
by following the instructions below: 

a. Run [NTBackup.exe] from [Start] -> [Run] 

b. Press the [Restore Wizard] button and then press the [Next] button 

c. Press the [Import] button and use the [Browse] button to select the backup file 
[SystemState.bkf] downloaded 

d. Select the checkbox next to the description that matches your backup file 

e. Press the [Next] button and then the [Finish] button 
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iv. Completed 
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13 Backup/Restore Individual Mailbox for Microsoft Exchange 
Server 
Please refer to the Ahsay Online Backup Suite Individual Mail for Exchange 2000 / 2003 Setup Guide for more 
information. 

 

http://www.ahsay.com/download/customer/document/guide_obm_exbrick.pdf
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14 Backup/Restore MySQL Server 
This chapter will describe in details how to use AhsayOBM to backup your MySQL server and how you can restore 
your MySQL server from the database backup files. 

14.1 Requirements 
i. AhsayOBM must be installed onto the computer running MySQL server. 

ii. Data from MySQL server will be backed up to a temporary directory before they are sent to Ahsay 
Offsite Backup Server. Please make sure you have sufficient space on your computer to store 
these data when you run the backup job. 

iii. There must be a MySQL account can be used to connect from localhost. 
 
Add two new MySQL accounts for Ahsay Backup Manager 
 
mysql> GRANT ALL PRIVILEGES ON *.* TO 'root'@'localhost' 
     -> IDENTIFIED BY 'some_pass'; 
mysql> GRANT ALL PRIVILEGES ON *.* TO 'root'@'localhost.localdomain' 
     -> IDENTIFIED BY 'some_pass'; 
mysql> FLUSH PRIVILEGES; 
 
They are superuser accounts with full privileges to do anything with a password of some_pass. 

14.2 Overview 
AhsayOBM will backup your MySQL server by taking the following steps: 

i. Run all Pre-Commands of this backup set 

ii. All database(s) (either local or external) selected are backed up to a temporary directory specified 
in its backup set  

iii. Run all Post-Commands of this backup set 

iv. Upload all backup files from the temporary directory to an Ahsay Offsite Backup Server 

v. Remove temporary files from the temporary directory if [Setting] -> [Temporary Directory for 
storing backup files] is enabled 
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14.3 How to backup MySQL server on Windows 
Please follow the instructions below to backup your MySQL server using AhsayOBM: 

i. Open AhsayOBM 
 
Right click AhsayOBM icon available in the system tray and choose [Open]  
 

 

ii. From the Menu, Choose [Backup Set] -> [New] -> [MySQL Backup Set] 
Create a backup set 

a. From the Menu, Choose [Backup Set] -> [New] -> [MySQL Backup Set] 
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b. Enter a name for your backup set 
 

 

c. Enter the root password, the MySQL server TCP/IP port number and the path to MySQL 
backup utility (mysqldump) 

d. Select the database(s) to be backup 
 

 

e. Enter a temporary directory for storing the backup files before they are sent to an Ahsay 
Offsite Backup Server, e.g. C:\Backup\MySQL 
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f. Set the backup schedule for Database Backup 
 

 

g. Set the encryption algorithm, encryption mode and encrypting key for this backup set 
 

 
 
(Hint: For maximum security, please select AES (Advanced Encryption Standard) Algorithm, 
CBC (Cipher Block Chaining) mode and use an encrypting key with more than 8 characters.) 
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iii. Run Backup  

a. Select the backup set you want to run on the left panel and press the [Start Backup] button 
(►) 

b. Select [Off-site Backup Server] to start backing up your files to an Ahsay Offsite Backup 
Server and press the [OK] button 
 

 

c. You should get something similar to the screen shot below. 
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14.4 How to backup MySQL server on Linux (command line mode) 
If you want to setup AhsayOBM to backup MySQL server running on Linux using command line mode, please do 
the followings: 

i. Create a backup account on AhsayOBS 

ii. Logon to the web interface of AhsayOBS using the backup account created in the previous step 
(doesn’t matter if it is not from the Linux server running the MySQL server to be backed up) 

iii. Create a new backup set by pressing the [Backup Set] -> [Add] button 

iv. Select the [Backup Set] -> [Type] -> [MySQL Database Server] radio button and press the 
[Update] button (which can be found at the bottom of the page) 

v. Setup all [Backup Set] -> [Database Backup Setting] 

Settings Descriptions 
MySQL Username (e.g 
root) 

A MySQL user account that has backup access to the 
databases to be backed up (e.g. root). Please refer to 
the [Requirements] section for details 

MySQL Password Password of the MySQL user account being used 

Host IP address / Hostname of the MySQL Server 

MySQL Connection 
TCP/IP Port 

TCP/IP port used to access the MySQL Server (default: 
3306) 

Path to MySQL backup 
utility (mysqldump) 

Full path to where mysqldump can be found (e.g. 
/usr/bin/mysqldump) 

Temporary Spooling 
Directory 

A temporary directory to be used to store all MySQL 
database dump files before they are uploaded to the 
backup server 

Enable Delete Temp. File Whether to delete the temporary MySQL database 
dump files after they are uploaded to the backup server 

 

vi. Setup the [Backup Set] -> [Backup Source] setting 

¾ Add an “MySQL” entry to the [Backup Source] if you want to backup all databases under this 
MySQL Server 

¾ Add two entries, “MySQL/database1” and “MySQL/database2”, to the [Backup Source] if you 
want to backup both “database1” and “database2” under this MySQL Server 
 
(Please use “\” instead of “/” if the MySQL server to be backed up is running on Windows 
instead of Linux) 

vii. Setup the [Backup Set] -> [Backup Schedule] by pressing the [Add] link next the the “Backup 
Schedule” sub-title 

viii. Install AhsayOBM onto the Linux server running MySQL server (Please refer to the [2.1 Installation 
of AhsayOBM] section for details. The command line mode installation instructions are available on 
the web interface) 

ix. Completed 
 
If you have started up the AhsayOBM backup scheduler in the previous step, selected databases 
will be backed up automatically at scheduled time 
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14.5 How to restore MySQL server 
Please follow the instructions below to restore MySQL server from an Ahsay Offsite Backup Server. 

i. Download the database backup files to be restored from the Ahsay Offsite Backup Server 
 
Please refer to the [5.3 Restoring file] section for information on how to download backup files 
from Ahsay Offsite Backup Server. 

ii. Restore the database named [db_name] from the database backup file [db_name.sql]: 

a. Connect to the MySQL server 
 
(Windows) C:\> mysql 
(Linux) [root@server ~]# mysql 

b. Create the database to be restored  
 
mysql> CREATE DATABASE IF NOT EXISTS db_name 

c.Restore the database backup file back into the MySQL server 
 
mysql> use db_name ; 
mysql> source db_name.sql ; 
 
If db_name.sql is not located in the current directory, please specify the full path to the 
db_name.sql file in the command above. 

iii. Repeat the same procedure for each database to be restored to the MySQL Server. 

iv. Completed 
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15 Email Reporting 
Ahsay Offsite Backup Server makes use of the email system to keep you informed with the status of your backup 
activities. Please make sure your contact information within the backup system is correct to receive the reports 
described in this chapter. 

15.1 New User Report 
When a new backup account is added to the backup server, a new user report will be delivered to the contact 
email(s) of the new account. The New User Report contains the following information:  

Sample Report 

 
 

Key Description 
Login Name  Login name 
Password Password 
Alias Alias 
Language Preferred Language for your backup report 
Contact Email Address that will be used to contact you 
Backup Quota Backup quota 
Backup Server Backup server 
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15.2 Forgot Password Report 
If you have forgotten your password, you can use the [Forgot Password] feature available on the web interface to 
have your password delivered to you through email. (Please refer to “Retrieve Forgotten Password” section in the 
next chapter for more information on how to retrieve your forgot password report.) The Forgot Password Report 
contains the following information:  

Sample Report 

 
 

Key Description 
Login Name  Login name 
Password Password 
Alias Alias 
Language Preferred Language for your backup report 
Contact Email Address that will be used to contact you 
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15.3 Backup Job Report 
For each backup job you have run, a backup job report will be sent to you by email. This report contains a 
summary for the backup job that was run and a full listing of all files being backed up by the backup job. The 
backup summary report contains the following information:  

Sample Backup Summary Report 

 
 

Key Description 
Backup Time The time when the backup job ran 
Backup Status The overall status of the backup job. Normally, you should see “Backup 

finished successfully” in this field. If you happen to get something else, 
please consult the attached full report for more information. 

New Files Total number and size of backup files added to your backup set 
Updated Files Total number and size of backup files updated in your backup set 
Deleted Files Total number and size of backup files deleted from your backup set 
Moved Files Total number and size of backup files relocated in your backup set 
  
Login Name Login name 
Alias Alias 
Language Preferred Language for your backup report 
Contact Email Address that will be used to contact you 
  
Backup Source All files/directories that will be backed up 
  
Backup Data Size The total backup data stored in the data area 
Retention Area Size The total backup data stored in the retention area. Old copies of updated 

or deleted backup files are retained in the retention area for the number of 
days as specified by the retention policy of the backup set before they are 
removed from the system. 

Backup Quota Backup Quota 
Remaining Quota Remaining Quota 
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The full backup report, which contains a full listing of all files backed up by the backup job, is attached to the 
backup job report email as a zip file. You need to unzip it before you can read the full report.  

Sample Report 

 
 

Key Description 
Backup Set The name of the backup set 
Backup Job The name of the backup job (which is the start time of the backup job) 
Backup Status The overall status of the backup job. Normally, you should see “Backup 

finished successfully” in this field. If you happen to get something else, 
please consult the attached full report for more information. 

Backup Time The time when the backup job ran 
  
Backup Log All messages logged when running this backup job 
New Files Total number and size of backup files added to your backup set 
Updated Files Total number and size of backup files updated in your backup set 
Deleted Files Total number and size of backup files deleted from your backup set 
Moved Files Total number and size of backup files relocated in your backup set 
  
New File List Full list of all backup files added to your backup set 
Updated File List Full list of all backup files updated in your backup set 
Deleted File List Full list of all backup files deleted from your backup set 
Moved File List Full list of all backup files relocated in your backup set 
 

 



committed to the success of your business 
Ahsay Offsite Backup Server v5.1

User’s Guide
 

 

Leb Shama Company Limited Page 112 of 120 (June 16, 2006)
 

15.4 Setting Change Report 
After you have updated your user profile or backup setting, a setting change report will be sent to you. This report 
allows you to track record of the changes that have been made to your backup account.  

Sample Report 

 
 

Key Description 
Login Name  Login name 
Alias Alias 
Language Preferred Language for your backup reports 
Contact Email Address that will be used to contact you 
Backup Quota Backup Quota 
  
Backup Source(s) All backup sources of the backup set 
Backup Schedule(s) All backup schedules of the backup set 
Filter(s) All backup filters of the backup set 
Retention Policy The retention policy of the backup set 
Transfer Size The transfer block size of the backup set 
Pre-Command(s) All Pre-Command(s) of the backup set 
Post-Command(s) All Post-Command(s) of the backup set 
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15.5 Inactive User Reminder 
You will receive an inactive user reminder in email if your account has been left inactive for the period of 7 days 
(or the period specified by the system administrator). This is to remain you that you have not been running 
backup for more 7 days. If you are a free trial user, your account will be removed from the system automatically if 
the system can track no records of your backup activities in the next 30 days after receiving this report.  

Sample Report 

 
 

Key Description 
Login Name  Login name 
Alias Alias 
Language Preferred Language for your backup reports 
Contact Email Address that will be used to contact you 
Backup Quota Backup Quota 
  
Last Login Time The last time you logon to the backup system 
Last Backup Time The last time you ran a backup job  
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16 Web Features 
Other than the features of AhsayOBM described in the previous chapter, the web interface of Ahsay Offsite Backup 
Server provides you access to some additional features that are not available in AhsayOBM. This chapter describes 
each of these features in details. 

16.1 Install AhsayOBM 
Before you can use AhsayOBM, you have to use the web interface of Ahsay Offsite Backup Server to install 
AhsayOBM onto your computer. Please refer to the installation section (Chapter 2) for information on how to 
install AhsayOBM onto your computer. 

16.2 Update User Profile 
You can update your user profile by using the [Profile] panel available on the web interface. To change your profile, 
just make any changes to your profit on the panel shown below and press the [Update] button.  

 

Key Description 
Quota Backup Quota 
Data Area Total number and size backup files stored in the data area 
Retention Area Total number and size of backup files stored in the retention area 
Total Upload Total number and size of backup files uploaded to the backup server 
Total Restore Total number and size of backup files restored from the backup server 
  
Login Name  Login name 
Display Name Alias of your backup account 
Language Preferred Language for your backup report 
Time Zone Your Time zone 
Contact Email Address that will be used to contact you 
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16.3 Request Forgotten Password 
If you have forgotten your password, you can retrieve it by simply entering your login name or your registered 
email address on the [Password Request] form and press the [Request] button. Your password will be sent to your 
registered email address automatically.   

 

16.4 Delete/Undelete Backup Files 
In addition to reviewing your backup activities from the email report and from AhsayOBM, you can also review any 
of your backup jobs by using the [Report] panel available on the web interface. To review a backup job, just select 
the required backup job from the [Backup Set] and [Backup Job] drop down list.  
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16.5 Review Backup Jobs 
In addition to reviewing your backup activities from the email report and from AhsayOBM, you can also review any 
of your backup jobs by using the [Report] panel available on the web interface. To review a backup job, just select 
the required backup job from the [Backup Set] and [Backup Job] drop down list.  

 

Key Description 
Job Status The overall status of the backup job. Normally, you should see “Backup 

finished successfully” in this field. If you happen to get something else, please 
click the [Detailed Report] images on the page. 

Backup Time The time when the backup job ran 
  
New Files Total number and size of backup files added to your backup set 
Updated Files Total number and size of backup files updated in your backup set 
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Deleted Files Total number and size of backup files deleted from your backup set 
Moved Files Total number and size of backup files relocated in your backup set 
  
Backup Data Size The total backup data stored in the data area 
Retention Area 
Size 

The total backup data stored in the retention area. Old copies of updated or 
deleted backup files are retained in the retention area for the number of days 
as specified by the retention policy of the backup set before they are removed 
from the system. 

Total Upload Total number and size of backup files uploaded to the backup server 
Backup Quota Backup Quota 
Remaining Quota Remaining Quota 
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You can open the [Full Backup Report] to review all information logged by a backup job by clicking the [Detailed 
Report] image on the [Report] panel.  

Full Backup Report 

 
 

Parameter Description 
Backup Set The name of the backup set 
Backup Job The name of the backup job (which is the start time of the backup job) 
Backup Status The overall status of the backup job. 
Backup Time The time when the backup job ran 
  
Backup Log All messages logged when running this backup job 
New Files Total number and size of backup files added to your backup set 
Updated Files Total number and size of backup files updated in your backup set 
Deleted Files Total number and size of backup files deleted from your backup set 
Moved Files Total number and size of backup files relocated in your backup set 
  
New File List Full list of all backup files added to your backup set 
Updated File List Full list of all backup files updated in your backup set 
Deleted File List Full list of all backup files deleted from your backup set 
Moved File List Full list of all backup files relocated in your backup set 

 

16.6 Review Storage Statistics 
You can review the amount of data you have stored on the backup server and uploaded to the backup server on 
each day by opening the [Statistics] panel available on the web interface. To review your storage statistics for a 
different month, just select the month you are after by selecting from the [Month] drop down list.  
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Key Description 
Date The date the following statistics are collected 
Data Area Total number and size of backup files stored in the data area on a particular 

date 
Retention Area Total number and size of backup files stored in the retention area on a particular 

date  
Uploaded Size Total number and size of backup files uploaded to the backup server on a 

particular date 
Total Storage Total number and size of backup files stored under your backup account on a 

particular date 
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17 Further Information 
17.1 FAQs  
Please see if your question has already been answered in our FAQs available on our website. 

17.2 Contact Us  
You can backup your data to an Ahsay Offsite Backup Server by following instructions below. 

i. Open AhsayOBM from the system tray 

ii. Choose [View] -> [About] from the top menu 
 

 

iii. Contact your backup service provider using the information shown in the [About] dialog box 
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